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File Menu

Use the commands in this menu to manage your composition and image files. You can open, save, and 
delete compositions, images, and libraries, and you can import Kodak PhotoCD images. You can print 
and scan images from here, and you can exit the program from the File menu.

See also Managing Files in Altamira Composer and External Image File Formats.

These are the items in the File menu:

New Composition
Compositions

Open Composition
Merge Composition
Save Composition
Save Composition As
Flatten Composition
Delete Composition Files
Composition Info

Images
Open Image
Save Image As
Import PhotoCD
Delete Image File
Image File Info

Libraries
Open Library
Save Library As
Delete Library Files

Scan/Print
Acquire Scan
Select Scan Source
Print

Exit



Managing Files in Altamira Composer

Unlike most graphics programs, when you use Altamira Composer, you seldom work on a single picture. 
Typically, you arrange and edit several pictures to create a composition. There are three basic graphic 
entities that you use in Altamira Composer:

    Images�

    Libraries�

    Compositions�

An image is a single raster picture of any size. You can create images using the various functions in 
Altamira Composer, or you can load images from standard file formats, such as TIFF or Targa. See 
External Image File Formats.

A library is a collection of, usually, two or more images. Library files are used as a handy way to collect 
and store a category of several images. For example, you might have a library file of tree images.

A composition is an arrangement of one or more images. It includes their positions relative to the 
composition guide, and their layered positions on the stack. (See Elements of a Composition.) A 
composition file also contains miscellaneous additional data, such as the grouping of images, status flags,
and several other system variables.

When you use Altamira Composer, you work on a single composition that is, in turn, made up of one or 
more images. You can add images to a composition in these ways:

    Use � Open Image to load an image from disk.
    Use � Open Library to load several images from a library.
    Use � Merge Composition to merge several images from a composition file.
      Use one of the functions in Altamira Composer to create a new image directly in the �
composition.

Altamira Composer displays a single composition at a time. You can, however, have several view 
windows open, each displaying a different view or zoom level of the current composition. Since a 
composition is made up of images, you can open or save any number of images to or from the current 
composition-either singularly, or as a library. Or, you can save the entire composition.



External Image File Formats

These are the types of external files that you can import into Altamira Composer:

    TIFF�

    Targa�

    Picio (Pixar)�

    JPEG�

    Windows BMP�

    PhotoCD�

You can export graphic components in these formats:

    TIFF�

    Targa�

    Picio (Pixar)�

    JPEG�

    Windows BMP�

    PostScript (.ps)�

    Encapsulated PostScript (.eps)�

In most cases, the above files are 24-bits or 32-bits. See "External Image File Formats" in chapter 4 of 
your Reference Manual for detailed descriptions of each of these file types.

Most of the file formats can be written to disk with or without the alpha channel. When you output an 
image without the alpha channel, Altamira Composer must decide whether the clear portion of the image 
(if any) should be converted to white, black, or any other color. See the No Alpha Background Color 
option under File Options for a method of specifying this.



New Composition

Select this to begin a new composition, replacing the current one. A dialog box appears when you select 
this command.

Enter the dimensions of your new composition in the Width and Height fields. The values can be in 
inches, pixels, or centimeters. The current unit is set by clicking on the arrow of the Size units popup 
menu.

The resolution of the composition is the number of pixels per inch, or pixels per centimeter. Set this by 
selecting one of the option buttons beneath Resolution units, and then placing a new value in the 
Resolution box.

Note: If the current unit is inches or centimeters, adjusting the resolution also changes the width and 
height settings. For best results, select your size units first, then set the resolution, and finally set the 
width and height.

If you want these settings to be used each time you perform a New Composition, click in the box beside 
Make these settings the defaults before you click on OK.

Caution:    All data in the active window is deleted when you begin a new composition. Be sure to save 
your composition before proceeding.

When you click on OK, a window is created containing a solid rectangle of a specified color over a gray 
void. You can think of the void as infinite in size. The rectangleor composition guideis part of the void, and
is a visual aid that defines the size of the composition you specified in the Width and Height fields of the 
New Composition dialog box. (You can specify the color of the composition guide with the Composition 
Guide Color option in the View Options dialog box.)

You can place images anywhere on the void, inside or outside of the composition guide, but when you 
use Flatten Composition to create a single, raster file, only those images, or parts of images, that are 
within the composition guide are included in the generated file.

When you create a new composition, the screen coordinates are zeroed at the upper-left corner of the 
composition guide. The x dimension is horizontal and runs from 0 at the upper-left corner of the 
composition guide, to positive values at the right, and negative values at the left. The dimension is vertical
and runs from 0 at the upper-left corner of the composition guide, to positive values downward, and 
negative values upward.



Compositions

Displays a submenu of items that let you open, save, and delete compositions, flatten a composition into 
a single, raster image file, or acquire information about the current composition.

A composition consists of a collection of one or more images, arranged according to their x/y position on 
the void, and their layered stack positions. The composition also contains information on the grouping of 
the images plus various flags describing the status of its images (locked, alert on updates, and so on).

These are the items in the Compositions submenu:

Open Composition
Merge Composition
Save Composition
Save Composition As
Flatten Composition
Delete Composition Files
Composition Info



Open Composition

Reads a composition from disk. The incoming composition replaces the current composition. A file dialog 
box appears.

1.    Select an .acc composition file, and then click on OK.
Result:  The composition in memory is deleted, the new composition takes its place, and its 
filename appears in the title bar of the view window.



Merge Composition

Lets you merge a composition into the current composition. A file dialog box appears from which you can 
select a composition. The images from the incoming composition are placed in front of the stack of 
existing images.



Save Composition

Writes the current composition to disk using the filename previously specified by the Save Composition 
As function. If no filename has been specified, a file dialog box appears in which you can specify a path 
and filename.

See "Save Composition" in your Owners Manual for a description of the disk files that are created with 
this command.



Save Composition As

Writes the composition to disk after first letting you specify a filename.

This function is exactly the same as Save Composition except that you are always given the opportunity 
to name the composition. Typically, you select this when you first save a composition, and then use Save 
Composition to update the already named composition. If you wanted to save a different version of the 
composition, you would use Save Composition As to provide a new name.



Flatten Composition

Creates a single image file out of all images within the composition guide. Use this command to create a 
raster file for subsequent processingsuch as printing.

When you select Flatten Composition, a file dialog box appears.

1.    Select the type of file you want to output, and enter a filename.
2.    Turn the Write Alpha option on or off.

The Write Alpha option determines whether alpha data is written with the file. If it is checked, alpha 
data is included; if it is not checked, any clear or semi-opaque pixels in the composition are colored 
by the composition guide. See Composition Guide Color in the View Options dialog box for a 
method of specifying the color of the composition guide. The default setting for the Write Alpha 
option is set by the Image File Write Alpha option in the File Options dialog box. 
Note: If you change the Write Alpha option in the file dialog box, it returns to its default setting the 
next time you flatten a composition. If you want a more permanent change, you must alter the 
Image File Write Alpha option in the File Options dialog box.

3.    Click on OK to write the file.
Result: All pixels that are within the composition guide are merged into a single image confined by 
the boundaries of the composition guide. The result is output as a single raster file.



Delete Composition Files

Lets you delete a composition file, and all its associated files. When you select this, a file dialog box 
appears.

    Select the composition file that you want to delete, and then click on OK.�

Result: The specified .acc composition file plus its associated files are deleted. Usually the directory
holding the files is also deleted.

Important:    If any files exist in the composition directory that are not composition files (extensions .ac*), 
then those files and the directory itself are not deleted. The composition file and its associated files, 
however, are deleted. See "Compositions" in your Owner's Manual for more about the structure of 
composition files.



Composition Info

Displays a dialog box containing information about the current composition, and lets you alter the width, 
height, and resolution of the composition guide. The dialog box that appears is the same as that used by 
the New Composition command. However, when you alter the settings, the composition guide is changed 
without erasing the images in your current composition. See New Composition for a description of the 
dialog box.



Images

Displays a submenu of commands that let you read and write images, import and export images, and 
define new images. From this menu, you can also import Kodak PhotoCD images.

These are the items in the Images submenu:

Open Image
Save Image As
Import PhotoCD
Delete Image File
Image File Info



Open Image

Lets you load an image into the current composition. You can choose from the various file formats 
described under External Image File Formats.

A dialog box appears in which you can specify the path, file format, and filename of the image. The 
loaded image becomes the current image. It is added to the front layer of the stack of images in the 
composition and appears in the upper-left corner of the active view.

Important:  If you import a Targa file and nothing appears to happen, it might be because the file contains
no alpha data, but is improperly flagged. Some applications write RGB Targa files that are incorrectly 
flagged as containing alpha data. When you import one of these files in Altamira Composer, the result is 
an invisible image. If this occurs, delete the image and change the Image File Read Alpha option in the 
File Options dialog box.



Save Image As

Saves the current image to disk. A file dialog appears in which you can specify a filename for the image.

The Write Alpha option in the file dialog box determines whether alpha data is written with the file. If it is 
checked, alpha data is included; if it is not checked any clear or semi-opaque pixels in the image are 
colored by the composition guide. The color of the composition guide is specified by the Composition 
Guide Color option in the View Options dialog box. The default setting for the Write Alpha option is set by 
the Image File Write Alpha option in the File Options    dialog box.

Note: If you change the Write Alpha option in the file dialog box, it returns to its default setting the next 
time you save an image. If you want a more permanent change, you must alter the Image File Write 
Alpha option in the Files Options dialog box.



Import PhotoCD

Displays an array of "thumbnail" pictures showing all of the images on the currently installed Kodak 
PhotoCD in your CD-ROM drive. 

1. Double-click to select the image you want to import. (Click on the Set Resolution button if you want 
to change the default resolution of the images.)
Result: The selected image becomes the current image. It is added to the front layer of the stack of 
images and appears in the upper-left corner of the active view.



Delete Image File

Lets you delete a specific image file from the disk. When you select this, a file dialog box appears.

    Select the image file that you want to delete, and then click on OK.�

Result: The specified file is deleted from the disk.

Caution: This is not the same as the image Delete command in the Edit menu. The image Delete 
command deletes only the current image from the composition in memory. It does not affect image files.



Image File Info

Displays information about a specified image file on disk. When you select this, a file dialog box appears.

    Select an image file, and then click on OK.�

Result: A message box appears containing information about the selected image file.

Note: You can obtain information about a specific image in your composition by double-clicking on the 
image. This displays a message box containing the position and dimension of the image, its size, and its 
filename (if any). It also reports the total amount of free memory in your system (including virtual disk 
memory).



Libraries

Displays a submenu of commands that let you open, save, and delete libraries of images.

Libraries are collections of one or more images. They are used primarily to store a category of images for 
handy retrieval, and they differ from compositions in these ways:

    The positions of the library images are stored only in relation to each other, and not in relation to �
the composition. Thus, when you open a library, its arrangement of images appears in the upper-left
corner of the current view. 
    Images are listed in the library file in the order that they are placed in the selection set before you�
save the library. When you reload the library, the images are layered based on the order they're 
listed in the image library. If you select the images using the Select Multiple command, they 
maintain their relative stack order (although they will all be reloaded in front of the stack). If you add 
the images to the selection set one at a time, the first image you add to the stack is the first image 
reloaded, the next image selected is reloaded on top of that, and so on. The last image you add to 
the stack is the last image reloaded, and becomes the current image.
    There is no grouping of images in a library file, and any status flags (such as Lock Position) are �
ignored.

These are the items in the Libraries submenu:

Open Library
Save Library As
Delete Library Files



Open Library

Loads a library of images from disk into the current composition. Library files (extension .all) are created 
with the Save Library As command. Using Open Library, you can read these files into the composition.

When you select this command, a file dialog box appears.

    Select a library file, and then click on OK.�

Result: The images in the library appear in the upper-left corner of the view, arranged as they were 
when they were last saved. The last image selected during the save process becomes the front 
image in the stack, and the current image.



Save Library As

Writes a selection set of images to disk as a collection of library files. A file dialog box appears.

    Specify a path and a filename, and then click on OK.�

Like a composition, a library usually consists of several images, and therefore requires several files. 
When you save a library, a descriptive file (extension .all) is created, plus a directory that holds image files
for each of the images in the library. The descriptive .all file, plus a directory of the same name are placed
on the specified file path, and the image files are placed in the directory. For details on the structure of 
library files, see "Save Library As" in your Owner's Manual.



Delete Library Files

Lets you delete a library file and all of its associated files. When you select this, a file dialog box appears.

    Select the library file that you want to delete, and then click on OK.�

Result: The specified .all library file plus its associated files are deleted, along with the directory 
holding the files.

For example, if you delete a library file called leaves.all, that file is deleted, all files in the leaves directory 
are deleted, and the leaves directory is deleted as well. See Save Library As for more about library files.

Important:  If any files exist in the library directory that are not library files (extensions .ac*), then those 
files and the directory itself are not deleted. The library file and its associated files, however, are deleted. 
Likewise, if you've used a text editor to create a library file, it might point to several directories. Only those
directories containing, exclusively, library image files (extension .ac*) are deleted. Since you can have a 
library file point to .tif files, for example, those files and their directory will not be deleted by this command.



Scan/Print

Displays a submenu of items that let you access scanning software and printers.



Acquire Scan

Runs the scanning software specified by the Select Scan Source command. The scanned picture is 
imported into the current composition as a new image and appears in the upper-left corner of the view 
window.



Select Scan Source

Displays a dialog box with a list of external scanner programs that you can run from within Altamira 
Composer.

1. Select the scanner you want to use.
2. Use the Acquire Scan command to run the program.



Print

Displays a dialog box from which you can print either the full composition, or the view in the current 
window. When you select this, the Print dialog box appears:

The top of the dialog box displays your current printer. You can change this through the Setup button, or 
through your Windows Control Panel or Print Manager.

The options in the Print Selection area determine which portion of your graphics is sent to the printer. 
Select Composition to print the composition, as defined by the composition guide. (See New Composition 
for information about the composition guide.) Select Current View to print the graphics displayed within 
the current view window. These two options use different methods of printing.

    Composition prints the images within the composition guide. To do this, it first flattens the �
composition into a single raster file which is stored on disk in a temporary file until the printing is 
completed. The advantage to using the Composition option is that you can print a composition that 
is larger than your display screen. The disadvantage is that large compositions take quite some 
time to print and require a lot of disk storage.
    Current View prints whatever you see in the current view window. You can resize the window to �
crop the area that's printed, and zoom to any level. The advantage to using this option is that it's 
generally much faster than the Composition option. The disadvantages are that you don't have 
precise cropping control because of limits in resizing Windows view areas, and although you can 
zoom out to print images larger than your view screen, the pixel quality diminishes greatly with 
zoomed-out images.

We recommend that you use Current View for draft printing, and then use Composition for final output.

In the Print Options area, Best Fit prints the selection in the correct aspect ratio while filling the paper 
within the limits of the current printer driver. Stretch to Page scales the image in all directions to fill the 
paper within the limits of the current printer driver. This ignores the aspect ratio of the image and usually 
results in distortion. The Scale options let you specify a scale factor along the X and Y dimensions. For 
example, if you turn this on and enter 0.5 in the X Axis field and 2 in the Y Axis field, the image is scaled 
to be half its width and twice its height.

The options in the Print Quality pop-down menu vary depending on the printer you're using. They might 
provide varying degrees of output resolution, or simply general qualities, such as draft, medium, high, and
so on. See your printer manual for details.

Note: If the resolution of your printer (in DPI) doesn't match the resolution you chose for your composition
(in the New Composition dialog box, or the Composition Info dialog box), then the output is scaled either 
up or down to match the printer's resolution.

When Print to File is checked, the data normally sent to the printer is sent to a specified file instead. You 
can use this with a PostScript printer driver to create a PostScript file of your composition.

The Copies field specifies the number of copies to be printed.

When you click on the Setup button, a Print Setup dialog box appears. Among other things, this dialog 
box lets you change printer drivers so you can print to another device. Other options in this dialog box 
vary with the printer driver. See your printer manual for details.



Exit

Select this to exit Altamira Composer. You can also exit the program by double-clicking on the Control-
menu box in the upper-left corner of the Altamira Composer window.

If your composition contains unsaved data, a dialog box appears. Select Yes to update or save your 
current composition before exiting (see Save Composition), select No to exit the program without saving 
the current composition, or select Cancel to keep the current composition and continue using the 
program.

If you have no unsaved changes, the Altamira Composer window closes when you select Exit.



The Edit Menu
Use the commands in this menu to edit your composition by duplicating, cropping, or deleting images. 
You can manipulate the RGB and alpha channels of an image, create selection sets of images, and undo 
the action of your last command. In general, the commands in the Edit menu function at the image level 
rather than the pixel level.

These are the items in the Edit menu:

Undo
Delete
Duplicate
Crop Image
Bounding Box Crop
Extend Image
Change Image Size
Extract Channel
Replace Channel
Broadcast Channel
Select

Image
Next Image
Template Image
Multiple
All
Nothing



Undo

Cancels the effects of the last command. This is not necessarily your last mouse stroke, however. For 
example, if you use Color Atop to paint several brush strokes before exiting the tool, and then select 
Undo, all of the brush strokes you added since selecting the Color Atop tool are undone.

Undo has no effect on moved images. You can restore an image to its original position using the Home 
command.

See also Recall Geometry, which lets you redraw a spline or polygon.

Note: Undo works by storing a copy of the current image in memory before a command is used. When 
you select Undo, the original image is retrieved. If the image is large, or there are several images in a 
selection set, this can use up quite a bit of memory. If you're short of memory, you can disable the undo 
buffer with the Undo Enabled parameter in the Edit Options dialog box.



Delete
Removes the current image from the composition. If there are several selected images, all images in the 
selection set are deleted.



Duplicate
Creates a copy of the current image, and makes the copy the current image. The duplicate image is 
placed directly in front of the original image.

Note: The home position of the original image is also copied to the duplicated. Thus, if you move the 
original image from its home position, and then duplicate it, when you home the duplicated image, it will 
move to the original's home position. See also Home.



Crop Image
Reduces the size of the current image, or selected images, to that of a defined box.

1.    Point to a corner and drag a box to define the new boundary of the image, or selection set.
Result: An outline of the box remains on screen for editing.
If you wish, you can now edit the size and position of the crop box. A small handle appears on the 
box at whichever location is nearest your mouse cursor. You can resize the box by dragging while 
the handle is at the corners or sides, or move the box when the handle is in the center. If you hold 
down the Ctrl key while dragging a corner, the box maintains its aspect ratio.

2.    Right-click and select Done, or press Enter to complete the crop operation.
Result: Portions of the image, or images that are outside of the box are deleted.

When you crop a single image, the box area that you defined becomes the new bounding box of the 
image. When you crop a selection set of images, the bounding box of each image is reduced by the part 
that was cropped

Any portions of the cropping box that are outside of the original boundaries of the images are ignored and
the original boundaries are retained.



Bounding Box Crop
Automatically fits the bounding box to the extent of the image's shape. The shape of an image is defined 
by its non-clear Alpha channel.

If you perform this on a selection set of images, each is cropped to the size of its shape.

Important: Bounding Box Crop resets the transform matrix of the image. See The Transform Matrix.



Extend Image
Increases the size of the current image, or selected images, to that of a defined box. This function is the 
reverse of the Crop Image function. See Change Image Size for more about image bounding boxes.

1.    Point to a corner and drag a box to define the new boundary of the image, or the images in the 
selection set.
Result: An outline of the box remains on screen for editing.
If you wish, you can now edit the size and position of the box. A small handle appears on the box at 
whichever location is nearest your mouse cursor. You can resize the box by dragging while the 
handle is at the corners or sides, or move the box when the handle is in the center. If you hold down
the Ctrl key while dragging a corner, the box maintains its aspect ratio.

2.    Right-click and select Done, or press Enter to complete the operation.
Result: Image boundaries that are inside of the extend-image box are extended to the new 
boundary. Image boundaries that are outside of the extend-image box are retained. The new pixels 
in the extended area are clear.



Change Image Size
Lets you define a box that both crops and extends the current image, or selected images. This command 
is a combination of the Crop Image and Extend Image commands.

Every image is surrounded by a bounding box that is displayed when you drag the image. You can see 
both the image and its bounding box by pressing the Shift key. Typically, in the case of rectangular 
images, the bounding box is the same size as the displayed shape of the image, but many images 
contain irregular shapes surrounded by clear pixels. This command lets you change the size of the image 
bounding box. If you increase the bounding box, the new area consists of clear pixels. If you reduce the 
bounding box to be smaller than the image's shape, then the image is cropped.

1.    Drag a box to define a new bounding box.
Result: An outline of the box remains on screen for editing.
If you wish, you can now edit the size and position of the box. A small handle appears on the box at 
whichever location is nearest your mouse cursor. You can resize the box by dragging while the 
handle is at the corners or sides, or move the box when the handle is in the center. If you hold down
the Ctrl key while dragging a corner, the box maintains its aspect ratio.

2.    Right-click and select Done, or press Enter to complete the operation.
Result: Portions of the image, or images that are outside of the bounding box are cropped; portions 
of the image that are inside of the bounding box are extended to the boundary of the new bounding 
box.

Note: When you apply this to a selection set of images, each image in the selection receives a bounding 
box that is the same size.



Extract Channel
Displays a submenu of items that let you create a new image from any channel of the current image.

This command functions differently, depending on whether you choose it from the menu, or from the tool 
bars. If you choose it from the menu, use the following procedure:

    When you select Extract Channels, a submenu appears listing the four channels. Select the �
channel you want to extract-Red, Green, Blue, or Alpha.
Result: A new image appears in which all of its RGB channels are copies of the selected channel, 
and its alpha channel is a copy of the source image's alpha channel.

You can apply any of the Altamira Composer functions to this image, and then reinsert it into its source 
image (or any other image) using the Replace Channel command.

If you choose Extract Channel from the tool bar, only the alpha channel is extracted.

Important:    When you edit an extracted color-channel image that you plan to replace, use black, white, 
or shades of gray for predictable results. Remember, when you replace a single color channel, your edits 
only affect the intensity of that color channel. When you edit an extracted alpha-channel image, only 
those functions that affect its transparency will affect the original alpha channel when you replace it.



Replace Channel
Lets you replace a specified channel of the current image with the matching channel of another image.

Replace Channel operates differently, depending on whether you choose it from the menu, or from the 
tool bars. If you choose it from the menu, use the following procedure:

1. When you select Replace Channel, a submenu lists the four channels. Select the channel of the 
current image that you want to replace-Red, Green, Blue, or Alpha.
Result: The cursor changes to the image-selection cursor.

2. Click to select another image (usually an extracted image).
Result: The matching channel of the selected image is copied into the specified channel of the 
current image, replacing the old channel.

If the second image is a different size than the current image, its upper-left corner is aligned with the 
upper-left corner of the current image and cropped if it is larger. If it is smaller, the pixels of the original 
channel remain in those areas not covered by the second image.

When you select Replace Channel from the tool bar, only the alpha channel is replaced.



Broadcast Channel
Replaces all channels of the current image with a single, specified channel.

This command functions differently, depending on whether you select it from the menus, or from the tool 
bar. If you select it from the menus, use the following procedure:

    When you select Broadcast Channel, a submenu appears listing the four channels-Red, Green, �
Blue, or Alpha. Select one to be broadcast to the other three. For example, select Green, to replace 
the red, blue, and alpha channels with the green channel.

When you select Broadcast Channel from the tool bar, only the alpha channel is broadcast.



Select
The Select command displays a submenu of items that allow you to select one or more images as 
current, or select the current brush template image.

You apply the various functions in Altamira Composer to either the current image, a temporary selection 
set of images, or a collection of images that are grouped into a single grouped image (see Group). 
Typically, you click on an image to select it as the current image, and then apply one or more functions to 
it. You can also click on an image and drag it to a different position in the composition. If the image is 
grouped, all of the images in the group are treated as if they are a single image.

When you apply a function to a selection set, the images in the set are treated as if each were a single 
image. It's as if you applied the same function to each image separately. Grouped images, on the other 
hand, are always treated as if the entire group were a single image. Thus, when you rotate a selection 
set, each image rotates about its own axis; when you rotate a group, the images maintain their positions 
relative to each other and rotate about the center of the group.

Selection sets and grouped images are two methods of working with multiple images, but they are really 
quite different. For one thing, selection sets are temporary; they disappear as soon as you select another 
image. Grouped images are more permanent, and you can nest groups within groups.

When you apply a function to a selection set, the images in the set are treated as if each were a single 
image. It's as if you applied the same function to each image separately. Thus, if you apply Shadow to a 
selection set, each image in the set receives a drop shadow.

Most functions in Altamira Composer can be applied to a selection set of images. As a general rule, a 
function that works on a current image will work on a selection set. The single exception to this are the 
Transforms which do not work on selection sets. On the other hand, selection sets cannot be used for 
source images or for brush template images.

These are the items in the Select submenu:

Image
Next Image
Template Image
Multiple
All



Select Image
This is the standard method of selecting and moving and image. Click to select the current image or 
grouped images, drag the mouse to drag the image or images.

To select or move an image:

1.    Click on any visible (non-clear) portion of an image. Or, if the image is over the void, click 
anywhere within its bounding box. 
Note: When the mouse cursor is over the bounding-box area of the current image, it changes to 
display an arrow with a small, hollow square attached. When it's over a selection set of images, the 
cursor square is divided by a cross, and when it's over a grouped set of images, the square on the 
cursor is solid. If the cursor points to a brush-template image that is not the current image, a small T
is attached to the cursor. See also Group and Select Template Image.

2.    Drag the mouse to move the selection.
Result: A bounding box appears around the image while you are dragging it. When you are not 
dragging the current image, you can temporarily display its bounding box by pressing the Shift key.

3.    Release the mouse to redraw the image in its new position. If you want to cancel the move, press 
Esc while dragging the selection.

You can also move the current image using the cursor arrow keys on your keyboard. As a default, the 
image moves one pixel for each keypress, and 10 pixels if you hold down the Ctrl key while pressing the 
cursor arrow keys. You can specify the distances with the Small Cursor Key Offset and Large Cursor Key 
Offset parameters (see Edit Options).

You can move multiple images if they're in a selection set or a group. However, moving grouped images is
much faster than moving a selection set of images.

You can add images to a selection set by holding down the Shift key and clicking on additional images.

Double-click on any image to display information about the image. A message box appears displaying the 
position and dimension of the image bounding box, its size, and the filename of the image (if any). The 
message box also reports the total amount of free memory in your system (including virtual disk memory).
See also Image File Info for a way to see information about an image file on disk.

Note: When an image is hidden behind another, you can bring it to the surface using the stack 
commands. See Raise.



Select Next Image

Selects the next image behind the current image in the stack.

You'll typically use this command with its Tab keyboard alternate. Each time you press Tab, the next 
image in the stack becomes the current image and is highlighted.

One use for this command is to make current an image that you can't see to click on.



Select Template Image
Lets you assign any image in the composition as the brush template. See The Touchup Menu, and The 
Applicator Buttons for details about how to use a brush template. The brush template can be used by the 
functions in the Touchup menu, and by several of the Warps.

    After choosing Template Image, the cursor changes to an image-selection cursor. Click on an �
image to make it the current brush template.
Result: The brush template applicator button in the sliders bar is turned on, if it wasn't already.

The shape of the image you select becomes the current brush template, but it does not become the 
current image. After you select the brush template, the program returns to the standard image-selection 
mode, and whichever image was current before remains the current image.

Note: When the mouse cursor is over a brush-template image, it changes to an arrow with a small T 
attached. If the brush-template image is also the current image, the cursor uses the standard display 
described in Select Image.

Once you have defined a brush template, the shape of its source image is available for Touchup and 
Warp functions until you select a new brush template with this command. If you alter or change the shape
pixels in the source image, the brush template is likewise changed.



Select Multiple

Use this to select multiple images by dragging a selection box around them.

    Choose Multiple and drag a box around the images you want to include within the selection set.�

Result: The images within the box become part of the selection set.
Note: The bounding box of each image must be entirely within the selection box for the image to 
become part of the selection set. If you're unsure of the size of an image's bounding box, select the 
image and press Shift.

Once you have completed dragging the selection box, the program returns to the standard image 
selection mode. If you click on an image outside of the selection set, the new image becomes current, 
and the previous images are released from the selection set.

You can add single images to an existing selection set by holding down the Shift key, and then clicking on 
other images. In much the same way, you can add multiple images to a selection set by holding down the 
Shift key before selecting the Multiple command, and then dragging a box around the images you want to 
add.

Note: If all images are included in the selection set, you can release them by clicking outside of the 
bounding box of the selection set, or by selecting Multiple and dragging a box around a subset of images.



Select All
Choose this to select all images in the composition. Once you have chosen this, the program returns to 
the standard image selection mode.

Note: When all images are included in a selection set, you can release them by clicking outside of the 
bounding box of the selection set, or by selecting a subset of images with the Multiple command.



Select Nothing

Removes all images from selection. Use this to deselect when all of the images in your view window are 
selected, and there's no visible void to click on. 

Note: After selecting nothing, you must click to select an image before you can proceed with any image 
functions.

The keyboard alternative for this command is Ctrl + 0 (numeric keypad zero).



The Organize Menu

The commands in this menu let you organize the images within your composition. You can group images 
so that positioning functions are applied to more than one image, and you can arrange the layered order 
of the images from front to back in the stack. You can also align one or more images to another image, 
and you can lock an image to prevent it from being moved.

These are the items in the Organize Menu:

Group
Ungroup
Explode Group
Collapse
Raise
Lower
Before
Behind
To Front
To Back
Align
Remember
Home
Lock Position



Group

Designates all currently selected images as a group. Grouped images are treated as a single image by 
the functions that position, or arrange an image within the composition. Functions that alter the visual look
of an image cannot be used with a grouped image. You can separate the images in a group using the 
Ungroup command.

This is how to place images in a group:

1.    Select two or more images.
2.    Select Group.

Images that you have already grouped can be placed into a larger group. For example, a group of apple 
images and a group of orange images can be made into a single group of fruit images.

Although you can use either grouped images or selection sets to work with multiple images, there are 
differences between the two. Selection sets are maintained only until you select another image. Grouped 
images are maintained until you choose to separate them with the Ungroup command. Thus, grouped 
images are more permanent, and you can nest groups within groups.

Note: You can tell that an image is a grouped set by watching the mouse cursor. When the cursor is over 
the bounding-box area of the current image, it changes to display an arrow with a small, hollow square 
attached. When it's over a grouped set of images, the square on the cursor is solid. When the cursor 
points to a selection set of images, the attached square is divided by a cross, and when it points to a 
brush-template image, a small T is attached. See also Select Imageand Select Template Image.

With the exception of Duplicate and Delete, grouped images are affected only by functions that change 
the position of an image in the composition. The following commands work with grouped images:

Move (dragging an image with the mouse)
Duplicate
Delete
Raise through To Back
Align
Remember
Home
Lock Position

If you want to apply a function such as Shadow to a grouped image, there are two ways to go about it:

    Ungroup the images, apply Shadow to each image in the group, and then regroup the images. �
This results in a separate drop shadow for each image in the group.
    Use � Collapse to create a single image out of the group, and then apply Shadow to the single 
image. This results in a single drop shadow for the now-single image. However, once you've 
collapsed a group, you can no longer separate its images.



Ungroup

Separates grouped images. If the group consists of smaller groups, only one level is ungrouped. In the 
fruit example given in the Group command, when you ungroup the fruit, you get two groups consisting of 
apples in one and oranges in the other. If you then ungroup the apples, you get individual apple images 
plus a group of orange images.



Explode Group

This command is like Ungroup, except that all levels of subgroups in the current group are ungrouped, 
leaving individual images. For example, if you Explode the fruit group, you get individual apple images 
and orange images and no groups.



Collapse

Permanently converts all elements of a group or selection set into a single, raster image that becomes the
current image. Using the example of the fruit in the Group command, the result is a single image of 
apples and oranges

Because most Altamira Composer functions cannot be applied to a group of images, you can first use 
Collapse to create a single image out of a group, and then apply the function to the single image. You can
apply this function to either a group of images, or a selection set of images. In either case, the result is a 
single, raster image.

Caution: Once a collection of images is collapsed, you can no longer separate them into individual 
images. If you are uncertain of the results, duplicate the group first, and then collapse the duplicate.



Raise

Raises the current image one level toward the front of the stack.

The images in a composition are maintained in a stack of layers. The front of the stack is the image that is
closest to you; the back of the stack is the image that is farthest from you. Each time you create or open a
new image, it is placed at the front of the stack. Use the Raise command to specify where in the stack you
want an image to be.



Lower

Moves the current image down one level toward the back of stack.



Before

Lets you move the current image one level in front of a selected image.

    When you select Before, the image-selection cursor appears. Click on any image in the �
composition.
Result: The current image is moved one level before the selected image.



Behind

Lets you move the current image one level in back of a selected image.

    When you select Behind, the image-selection cursor appears. Click on any image in the �
composition.
Result: The current image is moved one level behind the selected image.



To Front

Moves the current image to the front of the stack.



To Back

Moves the current image to the back of the stack.



Align

Displays a submenu of items that let you align two or more images. There are eleven possible methods of
alignment: Tops, Bottoms, Left Sides, Right Sides, Centers, UL (Upper Left), UR (Upper Right), LL (Lower
Left), LR (Lower Right), Equal Spacing, and Abut.

To align the current image to another image, do this:

    Select the method of alignment (Tops, for example), and then click on an image to which you �
want the current image aligned.
Result: The current image is moved so that its top edge is aligned to the top edge of the selected 
image.

To align multiple images to another image, do this:

    After selecting multiple images (see � Select), select a method of alignment (Centers, for example),
and then click on the image to which you want the multiple images aligned. This can be an image 
either inside or outside of the selection set.
Result: The centers of all of the images in the selection set are aligned to the center of the selected 
image. If the selected image is within the selection set, the images are aligned with the center of the
selection set's bounding box.

To apply equal spacing to several images, do this:

1.    Select several images and then select Equal Spacing from the Align submenu.
2.    Draw a box to specify the boundary and orientation of the alignment.

Once the box is drawn, you can edit its size and position. A small handle appears on the box at 
whichever location is nearest your mouse cursor. You can resize the box by dragging while the 
handle is at the corners or sides, or move the box when the handle is in the center.

3.    Right-click and select Done, or press Enter to perform the alignment.
Result: The centers of the two outermost images are aligned with the centers of the opposing 
smallest sides of the box. In addition, the centers of all of the images are equally spaced and 
aligned with the center of the box.

To abut the edges of two images, click on another image. The edge of the current image that is closest to 
the selected image abuts to the closest edge of the selected image.



Remember

Stores the screen position of the current image or group so that you can restore it with the Home 
command. A home position is stored with each image when it is created or loaded. When you use the 
Remember command, you update this home position to the current position of the image or group.



Home

Restores the current image or group to the position recorded by the Remember command. If Remember 
has not been applied to the image or group, it's restored to the position at which it was created, or the 
position at which it was loaded from disk. If you apply Home to a selection set of images, each image in 
the set is returned to its home position while remaining a part of the selection set.



Lock Position

Locks or unlocks the position of the current image. You cannot reposition a locked image until you unlock 
it by reselecting this command while the locked image is current.

This command does not lock an image into its stack position. (See Raise for information on stacks and 
layers.)

Lock Position works differently on selection sets as compared to groups. If a locked image is included in a
selection set, when you move the set, all images but the locked image move. If you apply the Lock 
Position command to a selection set, the lock status of all images in the set is reversed. Thus, locked 
images in the set become unlocked, and unlocked images become locked.

If one or more locked images is placed in a group, only the locked status of the group matters. Thus, if 
you lock the group, none of its images can be moved, while if you unlock the group, all of its images can 
be moved. When you ungroup a set of images, any of the images that were originally locked become 
locked again, while images that were originally unlocked, are once again unlocked.



The Tools Menu

This menu provides the principal tools that let you change the content or shape of an image. Many of 
these functions alter the overall shape of an image by rearranging its pixels. Others retain the shape of 
the image but alter the color of its pixels to the point where its visual content is different. Compared to 
this, the commands in the Enhance menu primarily change the color value of the pixels while maintaining 
the basic visual content of the image.

The commands in the Tools menu let you transform an image (rotate, scale, and so on); permute, or 
rearrange the order of its pixels (flip, transpose, etc.); warp its pixels into a distinct formation (bulge, star, 
barrel, etc.); apply special effects (blur, shadow, and so on); create new images made up of patterns 
(checkerboard, stripes, etc.); create new geometry images (ellipse, spline, polygon, etc.), and texture the 
current image, using pixel values from a second, source image.

These are the items in the Tools menu:

Transforms
Scale
Resize To
Rotate
Skew
Perspective
Bilinear

Permutes
Flip Up-Down
Flip Right-Left
Transpose Right
Transpose Left
Rotate Right 90
Rotate Left 90
Cyclic Shift

Warps
Bulge
Escher
Mesa
Vortex
Radial Sweep
Spoke Inversion
Schmudge
Star Disk
Barrel
Bow
Wave
Rectangular

Effects
Blur
Shadow
Edge
Edge Only
Wash
Complement Color
Luminance
Recess
Relief
Plug-Ins



Patterns
Color Array
Grayscale Array
Color Bars
Hue v Blackness
Hue v Whiteness
Ramp
Noise
Grayscale Noise
Checkerboard
Stripes
Text
Complement Shape
Color Lift

Geometry
Rectangle
Ellipse
Spline
Polygon
Recall Geometry

Textures
Texture
Texture Full
Glue
Snip
Intensity Map
Color Map
Xparency Map
Saturation Map
Tile

Plug-Ins



Transforms

Transforms (transformations) provides a submenu of functions that let you scale, rotate, or skew the 
image. You can also perform perspective and bilinear transformations.

See also The Transform Matrix.



The Transform Matrix

The Transform commands rearrange the pixels in an image and, in the process, generate additional 
pixels through a process called resampling. For example, when you increase the scale of an image, new 
pixels must be generated to fill the areas between the original pixels. Typically, these new pixels are the 
result of averaging the original neighboring pixel values.

Resampling unavoidably causes a slight loss of detail in the image because of the creation of new pixels 
or the deletion of existing pixels. This deterioration, or degradation of the image can increase 
exponentially if you resample an image that has already been resampled.

To prevent the deterioration caused by cumulative resampling, Altamira Composer maintains the original 
orientation of the image, plus a transform matrix that contains a history of its transforms. This means that 
you can apply cumulative transforms on an image with no more deterioration than would be caused by a 
single transform. For example, you can scale, then rotate, then skew an image, and there is only a single 
generational loss.

Important:    The transform matrix is reset for an image whenever you apply a function that alters the 
arrangement or color of the pixels within the image itself. For example, you can move an image on the 
screen, or use any of the Align functions without resetting the transform matrix. But, if you apply a Warp, 
or use a Touchup tool on the image, the transform matrix is reset.



Scale

Scales the image to or from its center. A box appears representing the current transforms of the image.

1.    Drag the mouse up or to the right to increase the scale; down or to the left to decrease the scale.
2.    Repeat the drag operation, if necessary, to adjust the scale.
3.    Right-click and select Done, or press Enter to apply the new scale. (Press Esc to cancel the scale.)

If you want to scale the horizontal and vertical dimensions independently, perform the above steps while 
pressing the Ctrl key.



Resize To

Displays a dialog box in which you can scale the current image to a specified width and height. Most of 
the numeric fields in the Resize dialog box are interrelated; when you change one value, another changes
as well

The current width and height of the image's bounding box appear in the Width and Height boxes. You can
alter the width and height by editing the values in these fields, or by changing the percentage of scale in 
the fields to the right.

If the Maintain Aspect Ratio box is checked, the Height values change as you alter the Width values, and 
vice versa. If you want to change the aspect ratio of the image, turn off the Maintain Aspect Ratio box.

Note: If you vary the width and height while Maintain Aspect Ratio is off, and then turn it back on again, 
the original aspect ratio is restored.

The current size of the image, in kilobytes, is displayed in the File Size box. You can use this, as well, to 
resize the image. When you change the File Size setting, the last adjusted aspect ratio is maintained, 
regardless of the state of the Maintain Aspect Ratio box. For example, if you turn off Maintain Aspect 
Ratio and set the Width to 640 and the Height to 480, if you reduce the Size value, the new aspect ratio is
maintained.

The Units drop-down list lets you set the current unit of measurement. This can be Pixels, Inches, or 
Centimeters. In any case, the ratio of units to pixels is set when you create a new composition. See New 
Composition.



Rotate

Rotates the current image, clockwise or counterclockwise, about its center. A box appears representing 
the current transforms of the image.

1.    Drag the mouse down or to the right to rotate clockwise; up or to the left to rotate 
counterclockwise.

2.    If necessary, repeat the drag operation to adjust the rotation.
3.    Right-click and select Done, or press Enter to apply the rotation. 



Skew

Tilts the image by shearing its opposing sides in opposite directions about its center. A box appears 
representing the current transforms of the image.

1.    Drag the mouse right and left to skew the top and bottom sides of the matrix box horizontally, or up
and down to skew the left and right sides of the box vertically. 

2.    If necessary, repeat the drag operation to adjust the amount of skew.
3.    Right-click and select Done, or press Enter to apply the skew. 



Perspective

Applies a two-point perspective to the image. A box appears representing the current transforms of the 
image.

1.    Drag the mouse in any direction. The direction you drag the mouse increases the size of the matrix
box in that direction while decreasing the size of the box in the opposite direction.

2.    If necessary, repeat the drag operation to adjust the perspective.
3.    Right-click and select Done, or press Enter to apply the perspective.

Result: The enlarged side of the image appears closer, while the reduced side is foreshortened.



Bilinear

This function lets you remap the current image to its bounding box, after first adjusting the position of any 
corner of the box.

A box appears representing the current transforms of the image. A small control square appears at 
whichever corner of the box is closest to the mouse cursor.

1.    Move the mouse toward a corner you want to move until the control square appears at that corner.
2.    Drag the mouse to move the corner.
3.    Repeat the operation with any corner, and then right-click and select Done to apply the transform.



Permutes

Permutes (permutations) differ from transforms in that they rearrange the pixels of an image but do not 
create new pixels. Unlike transforms, which require pixel resampling, permutes do not degrade the image.



Flip Up-Down

Flips the image from top to bottom about its center.



Flip Right-Left

Flips the image from right to left about its center.



Transpose Right

Flips the image diagonally while maintaining the position of its upper-right corner. The image is flipped as 
if it were a square. Thus, a short wide image becomes a tall thin image, and vice versa.



Transpose Left

Flips the image diagonally while maintaining the position of its upper-left corner. The image is flipped as if 
it were a square. Thus, a short wide image becomes a tall thin image, and vice versa.



Rotate Right 90

Rotates the image, by right angles, 90 degrees clockwise about its center. This form of rotation causes no
pixel resampling. If you need to rotate an image and it can be in 90-degree increments, use this rather 
than the Rotate command in the Transforms menu.



Rotate Left 90

Rotates the image, by right angles, 90 degrees counterclockwise about its center. This form of rotation 
causes no pixel resampling. If you need to rotate an image and it can be in 90-degree increments, use 
this rather than the Rotate command in the Transforms menu.



Cyclic Shift

Shifts the image a specified distance both horizontally and vertically. The shifted image wraps, so that 
pixels that fall outside of one side of the bounding area, appear on the opposite side.

You can set the distance and the direction of the shift in the Tools Options dialog box.



Warps

Warps distort an image and are like transforms in that they cause a resampling of the image's pixels. 
Unlike transforms, with some exceptions, repeated warps degrade the image with each application. Thus,
in general, each subsequent warp is applied to the result of the preceding warp rather than to the original 
image.

The following warps are exceptions to the rule and can be applied repeatedly without degrading the 
image.

    � Barrel and Bow can be applied repeatedly between themselves. For example, you can apply 
Barrel twice to an image, then apply Bow, and then Barrel again with only a single generational loss
in image quality.
    � Star Disk can be applied repeatedly to itself.
    � Schmudge can be applied repeatedly to itself

When you repeat one of these warps, you actually reapply the warp to the original image-in effect, 
adjusting the original warp. If you want to "warp the warp," you must first reset the transform matrix with 
the Bounding Box Crop command.

The first six warps in the menu can be used with a paintbrush, a brush template, or applied to the full 
image. The remaining warps are always applied to the full image. For a description of how to use a 
paintbrush and a brush template, see The Touchup Menu. In most cases, warps are more effective when 
applied to the full image, or with a brush template, but you can get interesting effects by using a 
paintbrush.

You can adjust most of the warp parameters in the Warp options dialog box.
 



Bulge

Causes the selected area of the image to appear to bulge out or in, as if it were wrapped around a 
concave or convex hemisphere with its center on the equator.

Select Warp Options in the Options menu to specify the direction of the bulge-in or out.



Escher

Inspired by the works of artist M.C. Escher, this warp causes the center of the selected area, to spread, 
crowding the area near its borders.

Select Warp Options in the Options menu to specify the amount of spread. The default setting of 150 
percent causes the center pixel to apparently grow 1.5 times its original size. A setting of 100 percent 
causes no spreading. A setting of 50 percent squeezes the center.



Mesa

Causes the selected area of the image to appear to be wrapped around a truncated cone-or mesa-that is 
pointing out of, or into the display.

Select Warp Options in the Options menu to specify the direction of the mesa (in or out) and the radius of 
its truncated cross-section. The radius value is the percentage of the radius of the base of the cone and 
specifies where the cone will be truncated.



Vortex

Twists the selected area of the image about its center while maintaining the orientation of the pixels at its 
borders.

Select Warp Options in the Options menu to specify the direction and degree of twist. For example, an 
angle value of 20 specifies a 20-degree, clockwise rotation of the center pixels. Specify a negative angle 
value to achieve a counterclockwise rotation.



Radial Sweep

Takes a specified line of pixels from the selected area, scales it to half the diameter of the area, and then 
sweeps the line around to form a disk.

Select Warp Options in the Options menu to specify the angle of the sampling line. In all cases, the line 
runs through the center of the selected area. At the default angle of 0, the line is horizontal. Positive angle
values rotate the line clockwise, and negative values counterclockwise.



Spoke Inversion

Inverts every spoke of an imaginary disk that just fits within the selected area of the image. A spoke is a 
line from the center of the disk to its circumference. The spoke is inverted by flipping its center end to the 
outside, and vice versa.

Select Warp Options in the Options menu to change the percentage of spoke that is sampled. For 
example, at the default setting of 100 percent, each spoke is created from the entire radius of the disk 
before it is inverted. At a setting of 33 percent, the spoke is sampled from the inner third of the disk radius 
and scaled to the full radius of the disk before it is inverted.



Schmudge

Warps the center of the full image to a position that you specify while maintaining the position of the pixels
at its boundary.

An intersecting box outline surrounds the image.

1.    Click and drag anywhere on screen to move the intersecting point of the box.
2.    If necessary, repeat the drag operation until the intersection is where you want it.
3.    Right-click and select Done, or press Enter to complete the schmudge.

You can apply Schmudge repeatedly without deteriorating the image, but each time you are actually 
readjusting the center point of the original image. If you want to schmudge a schmudge, you must first 
reset the transform matrix by applying Bounding Box Crop to the image.



Star Disk

Wraps the current image into a disk shape. You can apply Star Disk repeatedly, but each application is 
based on the original image If you want to apply this warp cumulatively, you must apply Bounding Box 
Crop to the image between applications.

An octagon appears over the image. To apply a disk warp, do this:

    Right-click and select Done, or press Enter.�

To enlarge the disk to a "superellipse," or apply a star warp to the image, do this:

1.    Click anywhere on screen and drag the mouse to the left to expand the corners of the octagon and
enlarge the disk effect, or drag the mouse to the left to contract the corners of the octagon and 
create a star effect.

2.    If necessary, repeat the drag effect to adjust the octagon.
3.    Right-click and select Done, or press Enter to complete the operation..



Barrel

The Barrel warp distorts the image by bulging its sides. You can also distort the image into a pincushion 
shape by pinching its sides. In either case, the four corners of the image's bounding box remain in place.

An intersection box outline appears over the image.

1.    Drag the mouse vertically to move the top and bottom center points of the box inward or outward; 
drag the mouse horizontally to move the side center points inward or outward. 

2.    If necessary, repeat the drag operation until the points are where you want them.
3.    Right-click and select Done, or press Enter to complete the barrel.

You can apply this warp and the Bow warp repeatedly. In either case, the warp is based on the original 
image. If you want to apply either warp cumulatively, you must reset the transform matrix between each 
application by applying Bounding Box Crop to the image.



Bow

The Bow warp is similar to the Barrel warp, except that each pair of sides moves in parallel directions. 
The current image is surrounded by the same intersecting bounding box.

1.    Drag the mouse vertically to move the top and bottom center points up or down; drag the mouse 
horizontally to move the side center points left or right.

2.    If necessary, repeat the drag operation until the points are where you want them.
3.    Right-click and select Done, or press Enter to complete the bow.



Wave

Applies a sine wave profile to the image. This is different than the Rectangular Sine warp, which 
rearranges only the pixels on a scanline while maintaining the overall rectangular shape of the image.

Select Warp Options to specify the frequency and amplitude of the sine wave, plus the direction of the 
amplitude (X Only, Y Only, or Both X&Y). When X Only or Y Only is selected, you can also turn on the 
Symmetrical option which mirrors the wave in both directions.



Rectangular

Squeezes the sides of the full image while expanding the center, or squeezes the center while expanding 
the sides. Technically, this command uses a mathematical function to rearrange the pixels on each of the 
horizontal scanlines, and then on each of the vertical scanlines.

Select Warp Options to choose one of three rectangular warp functions: Sine, Cosine, and Linear Knee. 
The Sine and Cosine functions move the pixels according to a sine or cosine function, respectively. The 
Linear Knee function does a linear scale up on each line to the left or below the knee position (from 0 to 
100). If the Symmetrical box is checked, the function is applied symmetrically to each scanline. In 
addition, you can choose to apply the function along the x and y dimensions, or along only the x or only 
the y dimensions.

The general effect of each of these functions is to squeeze a portion of the image toward its edge or 
toward its center while expanding the remaining portion.



Effects

The Effects menu contains miscellaneous functions that alter the size or the visual content of the image.



Blur

Creates a defocused, blurring effect. This function is different from Soften in two ways. You can specify 
the distance of the blurring to get a much stronger effect than Soften, and the resultant image expands in 
size, depending on the amount of blurring you specify. When you select Blur, a dialog box appears:

Specify the amount of blur in the horizontal or vertical directions. When the box beside Horizontal equals 
Vertical is checked, the values in the fields above are forced to be equal. Turn off the check box if you 
want different amounts of blurring horizontally and vertically.

You can set the Units popup to specify pixels, inches, or centimeters. (Pixels is usually used for this 
function.)

The overall size of the image increases based on the amounts specified. For example, if the Horizontal 
box is set to 2 pixels, and the Vertical box is set to 3 pixels, the image expands by four pixels horizontally, 
and six pixels vertically.



Shadow

Adds a drop shadow to the current image based on the silhouette of its shape. This enlarges the overall 
size of the image, depending on the offset of the shadow.

There are three parameters in the Tools Options dialog box that affect the color, the offset, and the 
opacity of the shadow. Use Shadow Color to specify an RGB color for the shadow; use Shadow Offset to 
specify the direction and distance of the shadow from the image; and use Shadow Opacity to specify the 
transparency of the shadow.



Edge

Adds an edge around the shape of the current image using a specified thickness, color, and opacity. As a 
result, the size of the original image is expanded by double the thickness of the edge.

Three parameters in the Tools Options dialog box affect the color, opacity, and thickness of the edge. Use
Edge Color to specify the RGB color; use Edge Opacity to specify its transparency; and use Edge 
Thickness to specify its thickness.



Edge Only

Adds an edge around the shape of the current image using a specified thickness, color, and opacity. The 
center of the image is then erase, leaving an outline. The size of the original image is expanded by double
the thickness of the edge.

Three parameters in the Tools Options dialog box affect the color, opacity, and thickness of the edge. Use
Edge Color to specify the RGB color; use Edge Opacity to specify its transparency; and use Edge 
Thickness to specify its thickness.

See Also Edge and Outline.



Wash

Makes the image transparent by varying its level of opacity. The current setting of the opacity slider is 
used to determine the transparency effect. For example, if an opaque image is washed with a 50-percent 
opacity setting, the resulting image is 50 percent opaque (half transparent). If a wash of 50 percent is 
applied to the image again, it become 25% opaque (75% transparent).



Complement Color

Changes all colors in the image to their complements, resulting in a color negative. You can undo this 
effect by repeating it.



Luminance

Changes the image into a monochrome image by replacing all pixels with the luminance of their color 
value. If the current image is already monochrome, there is no change.



Recess

Highlights the lower right edges of the image shape, and darkens the upper left edges. Effectively, the 
image appears recessed.

See also Relief.



Relief

Highlights the upper left edges of the image shape, and darkens the lower right edges. Effectively, the 
image appears in relief.

See also Recess.



Patterns

Most of the items in the Patterns submenu create rectangular images containing various patterns. Two 
exceptions are Text, Complement Shape, and Color Lift. Text creates a new image from a Windows-
compatible font, and Complement Shape and Color Lift each create a new images based on the current 
image.

For most Pattern commands, you drag out a box, and the pattern is created in the box. Exceptions to this 
(such as Tile and Ramp) are detailed in their respective sections. You can drag out a square instead of a 
rectangle by holding down the Ctrl key.

Once you've defined the box, its outline remains on screen and you can edit its size and position, if you 
want. A small handle appears on the box at whichever location is nearest your mouse cursor. You can 
resize the box by dragging while the handle is at the corners or sides, or move the box when the handle is
in the center. If you hold down the Ctrl key while dragging a corner, the box maintains its aspect ratio.

To complete the operation and render the pattern, right-click and select Done, or press Enter.



Color Array

Creates an image consisting of a 16 by 16 array of colored squares separated by transparent lines.

Suggestion: The Color Array is a good test image for transforms and warps.

See also Grayscale Array.



Grayscale Array

Creates an image consisting of a 16 by 16 array of gray squares separated by transparent lines.

See also Color Array.



Color Bars

Creates the CBS-standard, video color-bars pattern. This consists of eight vertical bars of color, 
consisting of the three primary colors, the three secondary colors, plus black and white. The bars are 
created at 75-percent brightness to avoid oversaturating broadcast video devices. They are arranged, left 
to right, in decreasing NTSC luminance.



Hue v Blackness

Creates a ramp of colors in which the hues vary horizontally, and increase in blackness vertically. The 
hues at the top of the image are pure, while those at the bottom are completely black.



Hue v Whiteness

Creates a ramp of colors in which the hues vary horizontally, and increase in whiteness vertically. The 
hues at the top of the image are pure, while those at the bottom are completely white.



Ramp

Creates a rectangular image consisting of a ramp of colors between the corners of the rectangle.

A ramp is a gradient blend of colors, usually between two end colors. The Ramp command in Altamira 
Composer blends in all directions between the four colors at the corners of the drawn rectangle.

When you select Ramp, a dialog box appears. The four color swatches in the dialog box represent the 
colors that are applied to the four corners of the drawn rectangular image.

1. To change any of the colors in the dialog box, click on its color swatch to display the Color Selection 
dialog box and select a new color.

2. While the Copy option is active, click on any of the border buttons between the color swatches to 
copy a color from one quadrant to another. You can copy the colors horizontally, vertically, or 
diagonally. For example, to copy the upper-left color to the lower-left corner, click on the button just 
above the lower-left corner. To copy the upper-left color to the lower-right color, click on the square 
button near the corner of the lower-right color.
If the Swap option is active, clicking on the border buttons swaps the colors on either side of the 
button. For example, if you click on either of the two uppermost vertical buttons, the colors in the 
upper-left and upper right corners are swapped.

3.    If you want to store the current set of colors for future use, enter a name in the Color Set field, and 
then click on Save. Likewise, you can restore previously saved color sets by selecting them from 
the Color Set pop-up list. To remove a color set from the list, select it, and then click on the Delete 
button. 

4.    After establishing the four colors, click on OK, and then drag a box to create the ramped image.



Noise

Creates an image filled with random color pixels.



Grayscale Noise

Creates an image filled with random gray pixels.



Checkerboard

Creates a checker pattern of clear tiles and tiles of the current color. A dialog box appears.

1. Enter the width and height of the tiles, and then click on OK.
2. Drag a box to define the overall size of the checkerboard.



Stripes

Creates a pattern of clear, horizontal stripes alternating with stripes of the current color. This function can 
also be used to create a special video field mask. When you select Stripes, a dialog box appears.

1. Enter the width and spacing of the stripes, or click on the Video Field button to set the stripes to 
every other scanline.

2. Click on OK.
3. Drag a box to define the overall size of the stripe pattern.

The pattern is always created with horizontal stripes. Use the Rotate Right 90 or Rotate Left 90 
commands to create vertical stripes, or the Rotate command to create diagonal stripes.



Text

Lets you create text shapes in the current color using TrueType or Adobe Type1 fonts in your Windows 
system. A dialog box appears.

    Enter your text in the text field at the top of the dialog box, and then click on OK to create an �
image of the text.

The current font, style, and size of the text appears in the Current Settings box. An example of the text in 
the chosen font is displayed in the window at the bottom of the dialog box. To change the font, style, or 
size, click on the Select Font button. A secondary dialog box appears.

    Select the font, the style, and the size from the list boxes. You can either click in the list box, or �
enter the specification directly in the text field above each list box. As you enter text in the box, its 
list updates to match the letters of the name you are typing. A sample of the font appears in the 
Sample box. When you have completed all specifications, click on OK to return to the Text box.



Complement Shape

Creates a new image containing the negative of the current image's alpha channel. The result is an image
containing opaque pixels of the current color where the original image was clear, clear pixels where the 
image was opaque, and transparent pixels of the current color where the image was transparent. This 
action takes place as soon as you select the command.



Color Lift

Creates a new image in the current color, by flooding outward to find pixels that match, or are close to the 
color of a pixel that you select. Among other things, you can use Color Lift to "fill" solid colors of an image,
or to create matte images based on similar colors in the current image.

Note: The Color Lift tool provides a somewhat "automatic" method for lifting sub-images from an image, 
but it's best used with areas of solid color or distinct borders. More often, you'll find the Spline tool 
superior (and faster) when you need to lift sub-images from complex images. See Lifting Sub-Images for 
a description of how to do this.

When you select Color Lift, the cursor changes to a Point? cursor, indicating that you should select a color
point in the current image. A tolerance slider appears in the sliders bar, and the status bar displays the 
following:

Press H/W/B for tolerances, (G)lobal, (L)ocal, (A)dd, (D)elete, (R)edo

These are the key presses that change the various Color Lift settings. The right side of the status bar 
displays the current values for hue, whiteness, and blackness, plus the active settings. Each time you 
select the Color Lift tool, the active settings are Hue, Local, and Add. By pressing the various keys, you 
can change the status of these three settings while using the Color Lift tool, but they return to their default
states when you exit the Color Lift tool.

The H, B, and W keys determine which of the three tolerance values are affected by the tolerance slider. 
As a default, the slider affects the hue tolerance. You can switch it to whiteness tolerance by pressing W, 
blackness tolerance by pressing B, and back to hue tolerance by pressing H. Regardless of which 
tolerance setting is displayed, the Color Lift tool uses all three tolerance values to compare pixels.

Note: Although the configuration of the settings is reset to Hue, Local, and Add each time you reuse the 
Color Lift tool, the three tolerance slider values are remembered.

1.    Determine your tolerance setting, and adjust the slider accordingly.
Press H, B, or W, and then adjust the slider. We recommend setting the blackness and whiteness 
tolerances to 100, and primarily adjusting the hue settings. To begin, set the hue tolerance very low,
between 2 to 6. The higher the setting, the more varied pixels are included. On the other hand, if 
you want to include only those pixels that perfectly match the hue of the selected point, set all three 
sliders to 0.

2.    Press L (local mode) or G (global mode).
When local mode is active, Color Lift looks only at neighboring pixels. When global mode is active, 
Color Lift looks at all pixels in the image that are within the tolerance level.

3.    Click on a pixel in the current image.
Result: Altamira Composer reads the color of the pixel you select, and searches for pixels that are 
of the same color, or within the tolerances specified. It then creates a new image whose shape is 
based on the found pixels, but whose color is the current color.
Note: If you select a pixel with no hue a gray, white, or black pixel), the Color Lift tool uses the 
current whiteness tolerance setting to compare grayscale values. So if you're working on a 
grayscale image, press W and adjust the whiteness tolerance. On the other hand, when you select 
a pixel with hue, pixels without a hue value are not included in the search.
When the new image is generated, you remain in the Color Lift tool and can edit the image using 
the following options:

    To add more pixels to the generated image, adjust the slider (if necessary) and click on another�
color in the original image. Additional pixels are generated in the current color, but are based on 



the new point color that you select.
Note: The color you select is taken from the source image, not the generated image. Thus, if the 
current color is red, and you've generated a partial color lift, if you click on the red area, the pixel 
from the source image, below, is used and not the red pixel.
    If you want to subtract from the new pixels, press D (delete mode), and then select a pixel. �
Press A to return to add mode and click to add more pixels. While in add mode, the Color Lift tool 
functions as described in previous steps. While in delete mode, the Color Lift tool subtracts rather
than adds pixels from the generated image. Again, the subtraction is based on the setting of the 
tolerance slider.

    If you want to try the same color point again, only with different settings, readjust the tolerance�
slider, or any of the Color Lift key-press settings, and then press R. The R key stands for "redo." 
It erases the last pixels that were generated, reselects the same point pixel that you last clicked, 
and then regenerates pixels based on the current tolerance setting.
Suggestion: If you simply want to undo the last result, press D (delete mode), press R to redo 
but delete the pixels, and then press A to return to add mode.

4.    Once the generated image is to your liking, right-click and select Done to exit the Color Lift tool.

Note: The generated image inherits the same size bounding box as its original, source image. If you 
want, you can use Bounding Box Crop to reduce the bounding box to the size of the new image.

While using the Color Lift tool, the following keyboard commands are available:

A    Add mode. While in this mode, pixels are added to the generated image, based on the selected 
point pixel.

D    Delete mode. While in this mode, pixels are subtracted from the generated image, based on the 
selected point pixel. You can be in add mode or delete mode.

G    Global mode. Color lift searches the entire image for pixels within the tolerance level of the point 
pixel.

L  Local mode. Only neighboring, connecting pixels within the tolerance level are affected. You can be 
in local mode or global mode.

H    Hue tolerance. The tolerance slider specifies how close the hue of the pixels must be to that of the 
point pixel.

W    Whiteness tolerance. The tolerance slider specifies how close the whiteness of the pixels must be 
to that of the point pixel.

B    Blackness tolerance. The tolerance slider specifies how close the blackness of the pixels must be 
to that of the point pixel. You can switch between hue, whiteness, or blackness tolerances, but the 
combined three values are used by the Color Lift tool.

R    Redo. Erases the last generated pixels, and reselects the same point pixel using the current Color 
Lift settings.

While using the Color Lift tool, you can switch between any of the keyboard commands at any time. 
Furthermore, you can adjust the tolerance slider and press R at any time in the process.

Important:  The Color Lift tool is one of few tools that generate aliased, "jaggy" images in Altamira 
Composer. We highly recommend that, after you generate the new image, you soften its edges with the 
Blur tool. In addition, the newly generated image inherits the same size bounding box as its original 
source image. Use Bounding Box Crop to reduce the bounding box to the size of the new image.



Geometry

The items in the Geometry submenu let you create images in the form of geometric shapes, such as 
circles, ellipses, rectangles, polygons, or splines. 



Rectangle

Creates a rectangular or square shape.

1.    Point to a corner, drag out a rectangle, and then release the mouse to define a rectangular or 
square box. (Hold down the Ctrl key while dragging the mouse to confine the box to a square.)
If you wish, you can now edit the size and position of the box. A small handle appears on the box at 
whichever location is nearest your mouse cursor. You can resize the box by dragging while the 
handle is at the corners or sides, or move the box when the handle is in the center. If you hold down
the Ctrl key while dragging a corner, the box maintains its aspect ratio.

2.    Right-click and select Done, or press Enter to draw the rectangle image.



Ellipse

Creates an ellipse or circle shape.

1.    Click and drag the mouse outward to display a box defining the boundary of the ellipse. (Hold 
down the Ctrl key while dragging the mouse to confine the box to a square, thus creating a circle.)
If you wish, you can now edit the size and position of the box. A small handle appears on the box at 
whichever location is nearest your mouse cursor. You can resize the box by dragging while the 
handle is at the corners or sides, or move the box when the handle is in the center. If you hold down
the Ctrl key while dragging a corner, the box maintains its aspect ratio.

2.    Right-click and select Done, or press Enter to draw the ellipse.



Spline

Creates a curved spline. A spline is an editable, curved line that is created by setting ducks (sometimes 
called control points). There are various parameters that affect the resulting spline. See Spline Options.

Note: The Spline tool provides the best method for lifting sub-images. This is described in Lifting Sub-
Images.

Regardless of the type of spline you create, this is the basic procedure:

1. Click the mouse to set the first duck of the spline.
2. Move the mouse and click again to set a second duck.
3. Repeat steps 1 and 2 until the spline is approximately to your liking. (You can edit it using the 

following steps.)
4. Right-click and select Done, or press Enter to complete the spline outline. (Press Esc to cancel the 

spline and return to image-selection mode.)
Result: A small square (a duck) appears on the spline nearest the location of your mouse cursor.
You are now in spline-edit mode. (The cursor changes to an arrow with a small duck symbol.) From 
here, you can move, insert, or delete the ducks. You can also toggle between an open or closed 
spline, a filled or unfilled spline, or a spline or polygon.
While in spline-edit mode, you can move the ducks by dragging them. A number of keyboard 
alternatives (described below) let you insert or delete the ducks, or otherwise alter the spline. Once 
you select an option, such as D for delete duck, the action is performed, and you are returned to 
movement mode.

5.    To render the spline, right-click to display a pop-up menu with the following list of rendering 
options:
Texture: Creates a new image by copying the portion of the current image that is beneath the 
drawn geometry. It works very much like the Texture Full command. The new spline image 
becomes the current image. Effectively, the new spline appears invisible until moved, since it's 
directly over a copy of itself.
When you use Texture, only that portion of the spline that is over the current image picks up the 
pixels; the remainder is clear. On the other hand, if none of the spline overlaps the current image, 
the spline is rendered using the current color. In this case, the function works the same as the Color
option, described next.
Note: If you make a mistake and the rendered spline is colored instead of textured, you can get the 
same effect by using the Texture Full command on the new spline image. Set the opacity slider to 
100, select Texture Full, and then click on the image overlapping the spline.
Color: Creates a new image in the spline shape using the current color. It doesn't matter where the 
spline is drawn, or if it's overlapping another image.
Erase: Cuts a hole out of the current image using the shape of the spline. No new image is created.
On the other hand, if none of the drawn spline overlaps the current image, then the spline is created
in the current color.
Continue/Done: Continue lets you continue with the operation, as if you hadn't right-clicked. Done 
is the same as selecting Color; it creates the spline in the current color.
Note: Rather than right-clicking and using the pop-up menu, there are single-key alternatives for 
the above options. Press X for Texture, C for Color, E for Erase, and Enter for Done. You can 
cancel the spline by pressing Esc.

6.    Select the rendering option to complete the spline.

While in spline edit mode, the following keyboard options are available. Many of these are the same 
options found in the Spline Options dialog box:



Move: Lets you reposition the ducks. You are automatically in this mode when you first complete 
the spline. As you move the mouse over the spline, the duck closest to the mouse appears and you 
can drag the duck to adjust the spline.
Insert: Press I to insert a new duck in the spline at a spot nearest the cursor, and then return to 
movement mode.
Delete: Press D to delete the currently displayed duck, and then return to movement mode.
Open: Press O to switch to an open spline. An open spline is not connected between its first and 
last ducks.
Closed: Press K to switch to a closed spline. A closed spline forms a continuous loop.
Filled: Press F for a filled spline.
Unfilled: Press U for an unfilled spline. An unfilled spline is drawn using either the current brush 
width, or the width set in the Spline Options dialog box, described on page 4-118.
Through: Press T to set the spline so that its line runs through the ducks. This gives you greater 
control in most instances, but might not result in as smooth a spline as Near (described next).
Near: Press N to set the spline so that its line runs near the ducks. This results in a spline that is 
smoother, but not always as easy to control.
Polygon: Press P to switch from a curved spline to a straight-line polygon.
Spline: Press S to switch from a straight-line polygon to a curved spline.



Lifting Sub-Images

The Spline tool is probably the best tool to use for cutting out, or lifting portions of an image. For example,
many of the images in the Altamira sample library files (such as the flowers) were lifted from larger, more 
complex images with the Spline tool. To do this, you activate the larger image, and then use the Spline 
tool (set to closed, and filled) to outline the sub-image that you want to lift. After editing the ducks, select 
the Texture option to copy the pixels from the larger image to the new sub-image.

The spline tool creates a smooth anti-aliased edge around the resulting image, but if you want a more 
feathered edge, you can do this: After lifting the sub-image, use Blur to soften its edge. Now, use the 
Texture command to re-texture the image. This restores the original sharpness to the pixels in the image, 
but leaves a soft, semi-transparent edge.

If you're lifting an image with all straight lines, use the Polygon tool instead of the Spline tool. If you're 
lifting an image with a combination of curved and straight lines, set the Spline tool to Near instead of 
Through and set two ducks at the corner points of the image.

Another method of lifting a sub-image is to use the Color Lift tool. It's best used with solid colors, or areas 
with distinct borders.



Polygon

This command is similar to the Spline tool, but the segments are straight lines instead of curves. The 
procedure for creating a polygon is exactly the same as that for creating a spline. See Spline for a step-
by-step description. See Polygon Options for details about polygon parameters.



Recall Geometry

Displays the outline of the last spline or polygon that you created, and places it in edit mode. You can now
use any of the options described under Spline. You can edit by moving, inserting, or deleting its ducks, or 
use the various keyboard alternatives to alter the nature of the geometry. When finished, right-click and 
select a rendering option.



Textures

The Texture commands are so named because they texture the current image with pixel values from a 
second, source image. Each Texture command requires a source and destination image. The current 
image is always the destination image, and is therefore the image that is changed by the function. The 
source image is an image that you choose after selecting the Texture function.

Note: The source image must be a single image. It cannot be part of a group or selection set. The current
image can be single, or a selection set, but it cannot be part of a group.

With the exception of the Tile command, the source and destination images must overlap at least partially
for the Texture function to work. However, the stack layer position of the two images doesn't matter. That 
is, the source image can be behind or in front of the destination image.



Texture

Replaces the shape pixels of the current image with those of an intersecting source image. Only the 
nonclear shape pixels of the source image are used. The clear pixels in the current image are not 
modified.

This command is similar to the Texture Full and Glue commands. In all three cases, the current opacity 
alters the effect of the function.

1. Adjust two images so that a source image intersects the current image. (The source image can be 
behind or in front of the current image, as long as it's in a position where you can select it.)

2. Select Texture, and then click on the source image.
Result: The shape pixels from the current image that intersect the shape pixels from the source 
image are replaced with those of the source image.



Texture Full
Replaces the shape pixels of the current image with those of an intersecting source image. Also alters the
transparency of the current image based on the alpha channel of the source image.

This command is similar to the Texture and Glue commands. In all three cases, the current opacity alters 
the effect of the function.

1. Adjust two images so that a source image intersects the current image. (The source image can be 
behind or in front of the current image, as long as it's in a position where you can select it.)

2. Select Texture Full, and then click on the source image.
Result: The shape pixels from the current image that intersect the source image are replaced with 
the color and transparency values of the source image pixels.



Glue

Replaces the shape and the clear pixels of the current image with those of an intersecting source image.

This command is similar to the Texture and Texture Full commands. In all three cases, the current opacity 
alters the effect of the function.

1. Adjust two images so that a source image intersects the current image. (The source image can be 
behind or in front of the current image, as long as it's in a position where you can select it.)

2. Select Glue, and then click on the source image.
Result: All pixels from the current image that intersect the shape pixels from the source image are 
replaced with those of the source image.



Snip

Erases the shape pixels of the current image using the overlapping shape pixels of a selected source 
image. Snip is a handy variation on the Erase command.

1.    Adjust two images so that a source image intersects the current image. (The source image can be 
behind or in front of the current image, as long as it's in a position where you can select it.)

2.      Select Snip, and then click on the source image.
Result: The shape pixels from the current image that intersect the shape pixels from the source 
image are erased.

The amount of erasure is affected by both the opacity slider, and the opacity of the pixels in the source 
image.



Intensity Map

Maps the intensity values of a source image to the current image while maintaining the color values of the
current image.

For example, if your source image is a gray ramp of colors from black to white, and your current image is 
a rainbow. After using the Intensity Map command, the rainbow colors will ramp from dark to light, picking 
up the intensities of the gray ramp. If, on the other hand, the current image was a solid red square, the 
result would be a ramp of dark-to-light reds.

1. Position the image you want to map so that it overlaps a second, source image.
2. Select Intensity Map, and then click on the source image.

The position of the source image in the stack layer does not matter. In all cases, the source image can be 
above or below the current image.

The Intensity Map Threshold parameter in the Tools Options dialog box determines the threshold (from 0 
to 255) at which the range of intensity affects the colors. The color pixels in the current image that are 
above the threshold value are brightened by the overlapping pixels of the source image, and those pixels 
that are below the threshold value are darkened by the corresponding pixels in the source image. Thus, if 
you set the threshold to 255, all color pixels in the current image are below the threshold and are 
darkened by the intensity values in the source image. The default setting for this parameter is 127.



Color Map

This works exactly the same as Intensity Map, except that it reverses the role played by the source and 
destination images. Thus, the color values of the source image are transferred to the current image, and 
the intensity values of the current image are not affected. Color Map is likewise affected by the Intensity 
Map Threshold parameter in the Tools Options dialog box.



Xparency Map

This works similarly to the Intensity Map, except that the transparency of the current image is altered 
based on the intensity of the source image. For example, if your source image is a gray ramp of colors 
from black to white, the current image is transparent where the source is black, and grows increasingly 
opaque toward the white end of the source ramp.



Saturation Map

This operates in the same fashion as Intensity Map and Xparency Map, except that the saturation of the 
current image is altered based on the intensity of the source image. White source pixels produce full 
saturation, while darker pixels reduce the saturation toward gray. Thus, if your source image is a gray 
ramp from white to black, the current image retains its original saturation at the white end, and gradually 
desaturates toward the black end of the ramp.

1.    Overlap two images.
2.    Select Saturation Map, and then click to select a source image.

Result: The saturation in the current image is altered based on the intensity of the source image.



Tile

Applies repeated, tiled copies of a source image onto the shape of the current image. For example, if the 
source is a small flower, and the shape in the current image is a large letter T, the flowers are tiled 
throughout the letter T.

    Select Tile, and then click on a source image.�

Although the source image does not have to overlap the current image, the origin of the tile pattern is 
based on the position of the source image. So, for the greatest accuracy, position your source image 
where you want the first tile in the pattern.

The position of the source image in the stack layer does not matter. In all cases, the source image can be 
above or below the current image.

The Intertile Spacing option in the Tools Options dialog box affects the spacing of the tiles. The default 
settings of 0,0 abut each of the tiles, side-by-side and top-to-bottom. A setting of 0,10 would maintain the 
side-by-side abutment, but add a 10-unit space between the top and bottom edges. You can use negative
values to make the tiles overlap.



Plug-Ins

If you've installed Adobe Photoshop-compatible filter plug-ins (extension .8bf or .eff), you may use this 
item appearing at the bottom of the Tools menu to let you access their effects. See the documentation 
that comes with your plug-ins for details on how to install and use them.

Plug-Ins can be applied to individual images in Altamira Composer using the Altamira Plug-in Toolkit.    
Here's how it works:

1.    Select the image in Altamira Composer to which you wish to apply the filter by clicking on it.

2.    Select Plug-Ins from the Tools pull-down menu.    This will automatically open the selected image in a 
window in the Altamira Plug-In Toolkit.

3.    In the Altamira Plug-In Toolkit, if you have not already done so, set the directory in which your plug-ins
can be found.    Do this by using the Options entry in the Plug-In pull-down menu.

4.    Use the Plug-In menu of the Altamira Plug-In Toolkit to see a list of the plug-ins available in the 
directory specified in step 3 above. Click on the desired plug-in name.    It will either execute immediately 
on the image or will display an interface provided by the plug-in vendor for specifying parameters before it
executes.    See the plug-in vendor documentation for details of how this works.

5.    After the selected plug-in has been applied to the image, simply return the results to Altamira 
Composer by clicking on the Return Image button (the horse) or select Return Result from the Image pull-
down menu.    The image will be returned to Altamira Composer as a new image object in the current 
composition.

6.    Images may be passed freely back and forth between Altamira Composer and the Altamira Plug-In 
Toolkit as described above.    When both programs are running, you can toggle between them by simply 
clicking on them one at a time or, if one of them is hidden by the other, by using Alt+Tab to reveal the 
hidden one.    You may have to use Alt+Tab several times to reveal the desired program if you have 
several running.



The Touchup Menu

The functions in the Touchup menu let you paint on the current image in three ways:

o    Using a paintbrush, you can apply a touchup function by dragging the mouse. The paintbrush is a 
circular shape of varying size, opacity, and softness, each of which you can set with the sliders bar 
at the bottom of your screen.

o    Using a brush template, you use the shape of another image as your brush. A brush template can 
be applied either by dragging with the mouse, or by single clicks. The method of application is 
specified with the Drag Template option in the Tools Options dialog box.

o    When Full Image mode is active, the function is applied to the entire image.

You choose from among the three methods of application either by selecting one of the first three items in
the Touchup menu (Use Paintbrush, Use Template, or Use Full Image), or by clicking on the applicator 
buttons in the sliders bar. The applicator buttons are three radio buttons representing, from left to right, 
the paintbrush applicator, the brush template applicator, and the full image applicator.

 For each Touchup function, you do the following:

1.    Either select one of the first three items in the Touchup menu, or click on one of the applicator 
buttons to specify the method of application.

2.    Select a Touchup function.
If you have chosen the paintbrush applicator, the cursor changes to a small circle. The size of the 
circle and the softness of its edge are determined by the brush size slider and the brush edge 
button on the sliders bar.
If you want to use a brush template applicator, you must first select the image to use as your brush 
template. This is done with the Select Template Image command, described on page 4-40. After 
selecting the Touchup function while Use Template is active, a bounding box the size of the 
template image appears attached to the mouse cursor.
If you have chosen the full image applicator, the Touchup function is applied to the current image 
immediately.

Note: You can switch between the different types of applicator without losing your brush template image, 
but there can be only one brush template at a time. Whenever you select a new brush template image, 
you replace the previous one.

See also Painting in a Selection Area

These are the items in the Touchup menu:

Use Paintbrush
Use Template
Use Full Image
Color Atop
Color Over
Xfer
Clone
Erase
Smear Atop
Smear Over
Impression
Dodge-Burn
Step Contrast



Tint
Colorize



Painting in a Selection Area

If you want to confine your Touchup painting to a selection area, do this:

1.    Use one of the Geometry tools, such as Spline to define a selection area over your image, and 
then use the Copy Out option to create the new geometry image as a copy of the pixels beneath.

2.    You can now use Color Atop with a paintbrush, for example, to paint on the shape of the 
"selection" image. For that matter, you can use any function that confines itself to the shape of an 
image.

If you want to make the changes permanent, you can place both the "selection" image and the original 
image in a selection set, and then use the Collapse command.

As an alternative to the above method, you can use an existing image as the selection area. Drag it into 
position over another image, and then use the Texture command to copy the pixels from the source to the
"selection" image. In this case, it's a good idea to use the Remember command to set the position of the 
"selection" image.

Note: Since any image in Altamira Composer can be used as a selection area, you can have an arbitrary 
number of selection areaseach of which are floating and can be manipulated with any of the functions. In 
addition, by using this technique, you can "undo" the effect at any time by either dragging the "selection" 
image out of the way, or simply deleting it.



Use Paintbrush

Turns on the paintbrush applicator for Touchup and Warp functions. You apply a function with the 
paintbrush by dragging with the mouse. The size and the edge of the paintbrush are controlled in the 
sliders bar by the brush size slider, and the brush edge button.

When this item is active, a check mark appears beside it.



Use Template

Turns on the brush template applicator for Touchup and Warp functions. A brush template is a shape 
derived from another image in the composition. When you apply the function, its effect is confined to the 
shape of the template image. Moreover, the opacity of the template image affects the function.

Before using a function with a brush template, you must select an image as the template with the Select 
Template Image command. This is simply matter of choosing Select Template Image, and then clicking on
an image in your composition. Note that any changes you make in the image used as the template 
change the brush template as well.

Note: When you choose a brush template image with the Select Template Image command, this 
applicator is automatically turned on.

When this item is active, a check mark appears beside it.



Use Full Image

When this item is selected, all Touchup and Warp functions are applied to the full image as soon as you 
select the function.

When this item is active, a check mark appears beside it.



Color Atop

Applies the current color onto the shape within the image, ignoring the clear areas. When used with a 
brush, this function resembles ordinary painting, but you can only paint on those areas of the image that 
contain non-clear pixels (as determined by the alpha channel).

If your opacity slider is set below 100, the color builds up as you paint repeatedly over an area. The effect 
is slightly different depending on the applicator. When using a paintbrush or dragging a brush template, 
the color builds as you move the mouse. When using full image, or a brush template in non-drag mode, 
the color builds with each application. If you do not want the buildup to exceed a certain opacity, use the 
Tint function instead.



Color Over

This is the same as Color Atop, except that you can paint over all areas of the image, including the clear 
pixels.



Xfer

Copies pixels from one area to another, while maintaining the relative offset of the source and destination 
areas. The source area, whose size is defined by the size of the paintbrush, or the shape of the 
applicator, can be anywhere in the composition, including the current image.

1.    Select Xfer, and then click on any image in the composition (including the current image) to define 
the source location.

2.    Move the mouse to the current image, and then click or drag the mouse to copy the pixels from the
source to the destination.
As you paint, the offset and angle between the source and the target area is maintained, regardless
of the number of mouse strokes. The transparency of the new pixels is controlled by the opacity 
slider.

3.    To reset the source and destination offset and angle, repeat steps 1 and 2.
4.    To exit, right-click and select Done, or select another function.

Note: If you use Xfer with full image active, a bounding box appears that's the size of the current image. 
As soon as you click on a destination image, the pixels are transferred. In this case, the shape of the 
current image dictates the pixels that are transferred.



Clone

Copies pixels from one area to another using a fixed source area. The Clone tool works exactly like the 
Xfer tool, except that the source area that you define is reused each time you apply a new mouse stroke. 
Thus, with each repeated mouse stroke, you are copying, or cloning the same area. The size of the 
source area is defined by the width of the paintbrush or the shape of the applicator.

Note: If you use Clone with full image active, the effect is exactly the same as Xfer.



Erase

Erases the shape of the current image, based on the shape and opacity of the applicator. Using a 
paintbrush that is completely opaque, for example, the non-clear pixels in the image become clear, letting 
you paint a "hole" in the shape. If the opacity slider is below 100 percent, the erased area becomes 
increasingly transparent as you repeatedly drag the paintbrush over it. If you use a brush template whose 
image contains semitransparent pixels, the erasure is affected by both the opacity slider setting and the 
opacity of the pixels in the template image.

If you apply Erase with full image active, and the opacity slider is set to 100, the entire image is erased. 
This is not the same as deleting the image, however. The bounding box of the erased image remains, and
you can paint on it using Color Over. You can move an erased image by clicking on it while it's over the 
void, or by using the cursor arrow keys. You can select an invisible image that's not current by using the 
Next Image command.
 



Smear Atop

Smears the pixels in the image in the direction that you drag the mouse. You can control the subtlety of 
the smearing by changing the opacity slider. If you think of the pixels as oil paint, a setting of 100 percent 
makes them a low-viscosity oil-easy to smear, while a lower percentage thickens the oil to a higher 
viscosity, making the pixels harder to smear.

Smear Atop confines the smearing to the non-clear pixels in the image, preserving its shape. See also 
Smear Over.



Smear Over

Smears the pixels in the image in the direction that you drag the mouse. You can control the subtlety of 
the smearing by changing the opacity slider. If you think of the pixels as oil paint, a setting of 100 percent 
makes them a low-viscosity oil-easy to smear, while a lower percentage thickens the oil to a higher 
viscosity, making the pixels harder to smear.

Smear over does not confine itself to only the non-clear pixels in the image. See also Smear Atop.



Impression

Provides an impressionistic "painterly" effect that varies depending on the size of the paintbrush and its 
opacity. For best results, draw with circular, repetitive strokes. Use either a small paintbrush with a high 
opacity setting, or use a low opacity setting with larger paintbrushes.

This function picks up the color under the paintbrush and then applies it with each paintbrush stroke. The 
faster you move the mouse, the more it "skips" picking up different colors along the way. The smaller the 
paintbrush, the more frequent the skipping, and the more often the color changes. Impression picks up 
and reappies the alpha data as well, so circular strokes near the edge of a non-rectangular image tend to 
randomize its shape.



Dodge-Burn

Darkens or lightens an area of the current image. This tool is named for photographic darkroom 
techniques that darken and lighten pictures.

When you select Dodge-Burn, a slider appears in the sliders bar with values ranging from 0 in the center 
to 50 at the far right, and -50 at the far left.

o    Adjust the slider to the right to brighten the image, adjust it to the left to darken the image.

If full image is active, the slider adjustments affect the current image. If you're using a paintbrush or brush 
template, you adjust the slider, and then apply the effect with the brush.

The setting you use specifies the maximum intensity value to be added or subtracted to the pixels. For 
example, a setting of 30 applied to RGB values of 20,100,240, results in values no greater than 
50,130,255 (255 is the highest RGB value possible).

The current opacity affects the rate at which the pixels are altered, but repeated applications of the mouse
will eventually reach the maximum value set by the Dodge-Burn slider.

If you want to increase the effect beyond the maximum value, either increase the value in the slider, or 
reselect the Dodge-Burn command to reset the limits. For example, you can burn pixels by no more than 
a value of 50. To reburn the already altered pixels an additional 50, select Dodge-Burn again.

The settings you use are absolute values until you reset them by reselecting the Dodge-Burn function (or 
any other function). While using Dodge-Burn, you can restore an area to its original value by drawing over
it with the Dodge-Burn slider set to 0.

See also Brightness.



Step Contrast

Provides an interactive method of altering the contrast of all color channels in the image. This command 
works exactly the same as Dodge-Burn, except that it affects the contrast rather than the brightness of the
image.



Tint

Tint applies a transparent wash of the current color to the current image. It's the same as using Color Atop
with a transparent color, except that Tint never exceeds the maximum value set by the opacity slider. Tint 
is also similar to Colorize, except that Tint modifies the existing colors whereas Colorize changes them. 
Also, Colorize does not affect pure black or white pixels whereas Tint does.



Colorize

Applies the current color without affecting the dark and light intensity values of the image. Colorize 
changes the color values of all pixels, with the exception of pure black or white pixels.

Suggestion: This tool is particularly useful for coloring monochrome images.



The Enhance Menu
The Enhance menu provides classic image processing effects, such as brightness and contrast control, 
tone control, hue and saturation adjustment, color balancing, softening, sharpening, and so on. In 
general, the functions here affect the status and intensity of the red, green, blue, and alpha channels of 
the image. This is in contrast with the commands on the Tools menu which actually change the pictorial 
content of the image, the position of its pixels, and even its shape.

These are the items in the Enhance menu:

Filter
Soften
Sharpen
Sharpen Lite
Emboss
Engrave
Outline

Compensation
Dynamic Range
Hue/Saturation Control
Brightness
Contrast



Filter

Displays a submenu of commands that let you filter the current image. Filters affect an image by 
performing a weighted average of the original value of each pixel with the original values of its 
neighboring pixels, and then applying the resultant values to the image.

The submenu Filter items are:

Soften
Sharpen
Sharpen Lite
Emboss
Engrave
Outline



Soften

Defocuses the image slightly by decreasing the contrast between neighboring pixels. You increase the 
effect by repeating this command. Soften is approximately the reverse of Sharpen.

Note: You can achieve a similar, though more extreme effect by using Blur. Keep in mind that Blur 
enlarges the overall size of the image, which is not the case with Soften.



Sharpen

Makes the image more distinct by increasing the contrast between neighboring pixels. You can repeat 
Sharpen a limited number of times to increase the effect, but after a certain number of repetitions the 
image begins to appear grainy. If the image appears grainy the first time you apply Sharpen, try the 
Sharpen Lite command instead.



Sharpen Lite

This is a more subtle version of the Sharpen command and is approximately the reverse of Soften. Use 
this when you want to lightly sharpen an image, or when the Sharpen command is too strong for the 
image.

Note: Soften and Sharpen Lite are not reversible commands. That is, while they appear to have opposite 
effects, if you soften an image after sharpening it, it is not restored to the precise state it was in before it 
was sharpened.



Emboss

Creates a bas relief effect by lightening the upper-left, contrasting colors in the image while darkening the 
lower-right contrasting colors. Emboss is the reverse of Engrave. See also Relief, for a tool that 
embosses only the edges of an image.



Engrave

The reverse of Emboss, this creates an intaglio effect by darkening the upper-left contrasting colors in the
image while lightening the lower-right contrasting colors. See also Recess, for a tool that engraves only 
the edges of an image.



Outline

Darkens all but the edges within the selected area. This function works best when your image contains 
areas of solid, contrasting color, but it can produce interesting effects on digitized or dithered areas.

See also Edge Only, for a tool that finds only the outside edges of the shape of an image.



Compensation

Lets you selectively adjust the contrast of the image by altering the brightness of its shadows, midtones, 
and highlights. You can perform this to all color channels or to individual color channels. The following 
dialog box appears:

1.    Click to select the channel you want to effect. You can alter all channels, or the red, green, or blue 
channels. 

2.    In the window at right, drag one of the three box handles in the line to affect the contrast of the 
selected channel. 
The leftmost handle affects the intensity of the shadows, the center handle affects the intensity of 
the midtones, and the rightmost handle affects the intensity of the highlights. Move the handles 
upward to increase the intensity, and downward to decrease the intensity.

3.    Click on Preview to see the effect of your adjustments on the image. This has no permanent effect 
on the image until you exit the dialog box.

4.    If you want to alter another channel, repeat steps 1 through 3. When you work with three channels,
each appears as a differently colored line.

5.    The pop-up menu in the upper-left of the dialog box lets you store different line configurations. 
Enter a name in the text field, and then click on Save to store the current settings. You can restore 
previous settings by selecting them from the pop-up list. To remove a setting, select it, and then 
click on Delete. Altamira Composer remembers up to 20 settings.

6.    If you want to reset the current line to its default, select no curve from the pop-up list.
7.    Select OK to accept the changes, or Cancel to cancel the changes and exit the dialog box.

Note: When you move from the All option to one of the Red, Green or Blue channel options, all three 
RGB lines are reset to the curvature setting from the All line. You can interactively adjust any three of the 
RGB lines separately, but if you return to All, the line is copied from the Red line and you lose the Green 
and Blue lines. When you save a setting, the stored setting remembers the last line option that was 
active. So if you want to save the three RGB settings, make sure the Red, Green or Blue options are 
active when you perform the save.



Dynamic Range

Lets you adjust the dynamic range of the image, or of a selection set of images. The dynamic range 
defines how intensity is distributed to the pixels in your image. A dialog box appears:

1.    Adjust the various options (described in detail, below), and then click on Preview to see their effect 
on the image without actually altering it.

2.    When you've achieved the effect you want, click on OK to keep the changes, or click on Cancel to 
cancel any changes you've made and exit the dialog box.

In the dialog box, the Output Range fields let you establish the overall range of intensity in the image. For 
example, if Low is set to 100, no pixels in the image can have an intensity lower than 100. Similarly, if 
High is set to 200, no pixels in the image can have an intensity higher than 200. Either of these values 
can range from 0 to 255. At the default settings of Low:0 and High:255, the pixels in your image are 
capable of a full range of intensity.

The window at right displays the dynamic range histogram of the current image. Vertically, the histogram 
represents the number of pixels in the image that are of a given intensity. Horizontally, the histogram 
represents the levels of intensity, from low at the left, to high at the right. When the Output Range values 
are set to their default 0 and 255, the left edge of the window is 0 intensity, and the right edge is 255.

As an example, if your image generates a histogram with a vertical spike in the center of the window, that 
spike represents the pixels in the image that have an intensity of approximately 128. If the spike is higher 
than all other peaks in the histogram, it means that more pixels in the image are of an intensity value of 
128 than any other value. If the histogram drops down to the bottom of the window before it reaches the 
extreme right edge, it means that there are no pixels with an intensity of 255 in the image.

At the lower-left and lower-right corners of the window are a pair of double arrows. These are handles that
let you drag a pair of vertical bars onto the histogram. (Click on the handles and drag right or left. You can
also click and drag the lines themselves.) The two bars reduce the size of the low/high intensity range. 
The left bar represents the current Low setting, and the right bar represents the current High setting. By 
moving the bars, you change which pixels in the histogram fall within the intensity range.

For example, given the default settings of Low: 0 and High:255, if you drag the left bar to the right, all 
pixels represented by the histogram that is left of the bar are forced to an intensity of 0. Similarly, if you 
move the right bar leftward, all pixels represented by the histogram that is right of the bar are forced to an 
intensity of 255.

The Enlarge Histogram and Reduce Histogram buttons increase or decrease the vertical scale of the 
histogram display, respectively. Since the scale is not altered horizontally, these buttons have no effect on
the dynamic range of the image, but you can use them to more accurately set the vertical bars.

The Auto Maximize button automatically moves the vertical bars to take the best advantage of the 
dynamic range of the image.

When you use the Dynamic Range Adjust dialog box with a selection set of images, the histogram 
represents the sum of the histograms of the images in the selection set.

Note: Altering the intensity of a pixel is exactly the same as altering the Value setting in the Color 
Selection dialog box without changing the Hue or Saturation settings. See The Current Color Swatch.



Hue/Saturation Control
Lets you adjust the hue or the saturation of the image. A dialog box appears.

The Hue slider tints the overall color of the pixels in much the same way as a tint knob works on a 
television set. Move the slider to the left for a bluer tint, and to the right for a greener tint.

Adjust the Saturation slider to the right to increase the saturation of the image, or to the left to decrease 
the saturation. Saturation is expressed as a percentage of change from the pixels' original values. You 
can enter a positive percentage, from 1 to 100, in the box above the slider to increase saturation, or a 
negative percentage, from -1 to -100 to decrease saturation.

Click on the Preview button to see the effect of your settings. The image itself is not actually changed until
you click on the OK button. (As usual, you can click on the Cancel button to exit the dialog box without 
altering the image.) If you want to restore the image to its original values without exiting the dialog box, 
click on the 0 buttons to reset the sliders, and then click on the Preview button.



Brightness

Alters the brightness of the selected area by a designated amount. You can perform this on all color 
channels or to individual color channels. A dialog box appears.

Slide the Brightness slider to the right to increase brightness, or to the left to decrease brightness. Or, you
can enter the percentage of brightness in the numeric box above the slider. A positive percentage, from 0 
to 100, increases the brightness, and a negative percentage from -0 to -100 decreases the brightness. 
Click on the 0 button to reset the slider to its 0 setting.

When the Channels option button is set to All (the default), all RGB channels are affected. Click on the 
RGB option button to affect individual color channels. The Brightness slider becomes a Red Brightness 
slider, and the Green Brightness and Blue Brightness sliders become active.

Click on the Preview button to see the effect of your settings. The image itself is not actually changed until
you click on the OK button. (As usual, you can click on the Cancel button to exit the dialog box without 
altering the image.) If you want to restore the image to its original values without exiting the dialog box, 
click on the 0 buttons above the sliders, and then click on the Preview button.



Contrast

Displays a dialog box to increase or decrease the contrast of the selected area of the image. You can 
affect all color channels, or individual color channels. This command uses the same type of dialog box as 
that used by the Brightness command. See Brightness for a description of its use.



The View Menu

The commands in the View menu affect the way your composition is displayed. From here, you can 
create additional windows, each of which can display different portions of the composition under varying 
zoom levels. Other commands let you pan the view, or arrange multiple views or view icons.

These are the items in the View menu:

New Window
Zoom in On Point and Zoom Out on Point
Pan
Move to Upper Left
Tile Windows
Cascade Windows
Arrange Icons
View #1, #2



New Window

Displays a submenu from which you can create a new window of the current composition, using various 
zoom factors. (See Zoom in On Point and Zoom Out on Point for a way to zoom the current view.)

You can have as many window views of the current composition as you like, but only one window is active
at a time. Typically, you might create a second window to display a zoomed-in view of one portion of the 
composition. You can work in any window, regardless of its magnification, and you can switch between 
view windows in the middle of a function. For example, you can begin creating a spline in one window, 
complete its creation in another, partially edit it in a third, and complete it in a fourth. To switch active view 
windows, click within the window you want to activate, and then proceed with the function you're using.

You can also move an image from the view in one window to the view in another. Simply click on the 
image in the first view, and drag the mouse across to the second view. When the image outline appears in
the second view window, release the mouse. Note that you're not actually moving the image from one 
window to another, but rather changing its position in the composition so that it's visible in the second 
window.

The New Window submenu offers zoom factors that are percentages of your original composition. Thus, if
you choose Zoom 200%, a new window appears displaying the composition twice its normal size. The No
Zoom (100%) item lets you create a second window with the no zoom factor. You can use this to display 
different areas of the same composition in two or more windows. When you're working on very large 
compositions, you can use the lower zooms, such as Zoom 10% and Zoom 25% to display the full 
composition in a secondary window.

See the Pan function for a way to move around in your zoomed windows.



Zoom In on Point and Zoom Out on Point

Zooms the display of the current window in or out, centered on a point that you specify.

To double the display in your current view, select Zoom In on Point, and then click within the current view 
to zoom in, centered on the mouse cursor position. Select Zoom Out on Point, and repeat the process to 
zoom out to 50 percent of the display.

The keyboard shortcuts are the most convenient way to use these commands, and perform the zoom 
immediately. Thus, when you press the + or - keys on your numeric keypad, the view zooms in or out, 
centered on the current mouse cursor position.

Note: The + and - keys in the top row of the standard portion of the keyboard do not work for zooming.



Pan

Scrolls the view of the composition in any direction.

1. Click and drag the mouse in the active window to display a line. When you release the mouse, the 
window view is panned.

2. Repeat step 1 to continue panning the window. To exit, select another function, press Esc, or right-
click and select Done from the pop-up menu.

Visually, it appears that you've moved the composition in the direction of the line. In reality, the window 
view is panned in the opposite direction of the line.

Note: There is another form of pan that is accessed through the pan button on the sliders bar. With it, you
pan the active window only once each time.



Move to Upper Left

Repositions the current view window so that the upper-left corner of the composition guide is in the upper-
left corner of the window.



Tile Windows

Resizes and arranges the composition view windows so that they all fit within the Altamira Composer 
workspace, side by side. The currently active window is placed at the left.



Cascade Windows

Rearranges the composition view windows so that they overlap and each title bar is visible.



Arrange Icons

Rearranges the minimized composition view icons evenly along the bottom of the Altamira Composer 
workspace.



View #1, #2

This portion of the Views menu displays an expanding list of each view window. Select any of the 
windows on this list to activate it and bring it to the front of the stack of windows. Of course, if the window 
is partially visible on your desktop, you can simply click on it to bring it to the front.



The Options Menu

The Options menu lets you specify preferences and default values for many of the commands in Altamira 
Composer. In addition, you can determine which tool bars are displayed.

Note: All changes you make in the Options dialog boxes are stored in your composer.ini file and remain in
effect each time you run Altamira Composer. You can reset any of the options to their original start-up 
values with the Default Value button in each of the dialog boxes.
These are the items in the Options menu:

File Options
Edit Options
Tools Options
Warp Options
Spline Options
Polygon Options
View Options
Show Tool Bars
Smart Cursor



File Options

Lets you set options that affect various items in the File menu. A dialog box appears from which you can 
select an option and set its parameters.

To adjust an option in the dialog box, do this:

1. Select the option you want to set from the File Option list at left. The available fields at right change, 
depending on the option you select.

2. Enter your changes in the fields to the right of the File Option list.
3. Click on OK to accept the changes, or Cancel to cancel the changes.

The Default Value button resets the selected option to the values preset by Altamira Composer.

The File Options dialog box contains the following options:

Image File Read Alpha: When set to the default, Yes, this assumes that an imported file contains 
alpha. When set to No, an imported file is assumed to have no alpha and is provided an opaque alpha 
channel. A number of applications produce Targa files that contain no alpha data but are erroneously 
tagged as containing alpha. When Altamira Composer reads these images, it assumes that the alpha 
is set to zero (clear). As a result, when you import one of these files, you receive an invisible image. If 
this happens, delete the image, switch this preference to No, and then reload the image.

Image File Write Alpha: Sets the state of the Write Alpha option in the Flatten Composition dialog box
and the Save Image As dialog box. This, in turn, determines whether or not the alpha channel is saved
with an exported image file. If the alpha channel is not saved with the exported file, the color of the 
clear pixels in the alpha channel is set by the composition guide.The color of the composition guide is 
specified by the Composition Guide Color option in the View Options dialog box.

JPEG Quality: Specifies the quality of the JPEG compression when you are exporting files in JPEG 
format. This can range from 0-100, where 0 is low quality and 100 is high. The default setting of 90 
results in little appreciable loss of detail in the restored file. See "Image File Formats" in chapter 4 of 
your Reference Manual for more about JPEG compression.

PostScript Color: Specifies whether an output PostScript file is color or grayscale

TGA, BMP Degamma Correct: Removes the gamma correction often included with Targa and BMP 
files. Targa, BMP, and Kodak PhotoCD images are often stored with gamma correction. Since Altamira 
Composer assumes no gamma correction, the midrange tones in these images will appear washed 
out, or too bright when you load them. To remove the "correction," set this parameter to Yes, and then 
reload the image. (Kodak PhotoCD images are corrected by using the Degamma Correct option in the 
PhotoCD dialog box.)

Caution:    This parameter alters the color values of the image, so you might consider resaving it under
a different filename. Also, remember to reset this to No after converting your gamma-corrected images.
This parameter has no effect on other file types.

TIFF File Compression: You can export TIFF files with or without compression. This preference is set 
to Yes (compressed) as a default. Some applications, however, cannot read compressed files, in which
case, you should set this to No.



Edit Options

Lets you set options that affect several of the commands in the Edit menu. A dialog box appears with a list
of options.

To adjust an option, do this:

1. Select the option you want to set from the Edit Option list at left. The available fields at right change,
depending on the option you select.

2. Enter your changes in the fields to the right of the Edit Option list.
3. Click on OK to accept the changes, or Cancel to cancel the changes.

The Default Value button resets the selected option to the values preset by Altamira Composer.

The Edit Options dialog box contains the following options:

Small Cursor Key Offset: Specifies the distance that an image is moved with the cursor arrow keys. 
The default values move the image 1 pixel along the x axis when you press the right or left cursor 
keys, and 1 pixel along the y axis when you press the up or down cursor keys.

Large Cursor Key Offset: Specifies the distance that an image is moved with the cursor arrow keys 
when combined with the Ctrl key. The default values are 100 pixels along the x and y axes. 

Pick Color Picks Opacity: Determines whether or not the pick color button on the sliders bar, 
changes the opacity as well as the current color. The default setting for this is No.

Undo Enabled: Specifies whether or not the undo buffer is enabled. The Undo function works by 
storing the changes you make into an area of memory called the undo buffer. Then, when you select 
Undo the data in the undo buffer is copied back to the current display. As a default, this option is set to 
Yes so that the Undo function is available. You would only set this to No if you needed the extra 
memory normally required by the undo buffer.

Caution:  If you set Undo Enabled to No, your actions cannot be undone.



Tools Options

Lets you set options that affect various commands in the Tools menu. A dialog box appears from which 
you can select and adjust the options.

To adjust an option, do this:

1. Select the option you want to set from the Tool Option list at left. The available fields at right change,
depending on the option you select.

2. Enter your changes in the fields to the right of the Tool Option list.
3. Click on OK to accept the changes, or Cancel to cancel the changes.

The Default Value button resets the selected option to the values preset by Altamira Composer.

The Tools Options dialog box contains the following options:

Cyclic Shift Offset: Sets the distance and direction that an image is shifted when you use the Cyclic 
Shift function in the Permutes submenu of the Tools menu. The default setting is 10 units along the x 
axis and 10 units along the y axis.

Drag Template: Specifies whether or not you can drag a brush template with the mouse. When this is 
set to Yes, you can drag a brush template to apply a function; when it's set to No, the function is 
applied through the template with each click of the mouse. If you are using large images for your brush
template, we recommend that you set this option to No. See The Touchup Menu.

Edge Color: Sets the color of the edge pixels generated by the Edge and Edge Only functions in the 
Effects submenu of the Tools menu. The default for this is 0,0,0, or black, but you can set it to any 
RGB value.

Edge Opacity: Sets the opacity of the edge pixels generated by the Edge and Edge Only functions. 
The default setting is 100 percent (full opacity).

Edge Thickness: Sets the thickness, in pixels, of the edge generated by the Edge and Edge Only 
functions. The default thickness is 1 pixel. The range is 1 to 100.

Intensity Map Threshold: Ranges from 0 to 255. This parameter determines the threshold at which 
the range of intensity affects the colors when using the Intensity Map command and the Color Map 
command. The color pixels in the current image that are above the threshold value are brightened by 
the overlapping pixels of the source image, and those pixels that are below the threshold value are 
darkened by the corresponding pixels in the source image. 

Intertile Spacing: Sets the offset of the margins of tiled images when you use the Tile effect in the 
Tools menu. The default setting is 0,0, which abuts the tiles at their edges. You can increase the x or y 
increment in a positive direction to space the tiles, or use negative numbers to overlap the tiles.

Shadow Color: Sets the color of the drop shadow generated by the Shadow function in the Effects 
submenu of the Tools menu. This defaults to 0,0,0, or black, but you can set it to any RGB value.

Shadow Offset: Specifies the offset distance and direction of the drop shadow generated by the 
Shadow function. The default setting is equivalent to 5 pixels along the x axis and 7 pixels along the y 
axis. Positive values place the shadow to the right along x and down along y; negative values place 
the shadow in the opposite direction.

Shadow Opacity: Determines the opacity of the drop shadow. The default setting is 80 percent 



opaque.



 Warp Options

Displays a dialog box to specify the parameters for the various Warp functions.

Select the type of warp from the list box at left. The appropriate settings for the selected warp appear at 
right. Click on the Default Value button to reset the selected warp to its default system settings.



Spline Options
Lets you set the parameters for the Spline tool. 

The descriptions below cover the settings that are available in the Spline Options dialog box.

Type: When Through is selected, the line of the spline runs through the ducks you create. This gives 
you greater control when you're setting the ducks of the spline, but the spline will not be as smooth 
while you're creating it. When Near is selected, the line of the spline runs near the ducks you create, 
but does not necessarily run through the ducks. This gives you less control when you're setting the 
ducks, but results in a smoother spline. Regardless of the method you use, you can later edit the 
spline for greater accuracy.

Style: Lets you choose between an open or closed, or filled or unfilled spline. An open spline has a 
space between its first and last ducks; a closed spline is a continuous line. A filled spline uses the full 
area of its geometry. An unfilled spline uses the perimeter line of the geometry.

If you choose Open, you can turn Taper on or off. When Taper is active, you can alter the width, 
opacity, and color of the line, from one end to the other, by using the Start Conditions and End 
Conditions settings, described below. If you choose Closed, you can turn Fill on or off, but you cannot 
use Taper. Conversely, if you choose Open, you cannot turn on Fill.

Granularity: Lets you set the smoothness of the spline segments (the lines between the ducks). Each 
curved segment is actually made up of tiny lines that together give the appearance of a curve. The 
more lines in a segment, the smoother the curve. The Granularity value is the number of lines in each 
segment. Thus, if you set the Granularity to 2, for example, each segment of the spline consists of two 
lines and the spline is not smooth.

Start Conditions/End Conditions: The Start Conditions box lets you specify alternate width, opacity, 
or color settings than those defined on the sliders bar at the bottom of your screen. To render your 
spline using the current paintbrush settings, click to activate the options below Current Brush. To use 
the alternate settings, turn off the associated Current Brush setting.

The End Conditions box is only available when the Open and Taper options are active in the Style box.
The End Conditions specify the width, opacity, and color of the end of a tapered spline. When a 
tapered spline is rendered, the values specified in the Start Conditions box are used for the start of the 
spline, and the values specified in the End Conditions box are used for the end of the spline. The three
values are smoothly tweened, or interpolated, from start to end, over the length of the spline. 

Copy/Swap: The Copy and Swap options let you either copy or swap the start and end conditions. 
The three rectangular buttons below perform the specified action to the width, opacity, and color 
settings, respectively. For example, if the Swap option is active and you click on the second button, the
opacity settings are switched between the start conditions and the end conditions. Similarly, if the Copy
option is active and you click on the third button, the start color is copied to the end color.



Polygon Options

Lets you set the parameters for the Polygon tool. 

The descriptions below cover the settings that are available in the Polygon Options dialog box.

Style: Lets you choose between an open or closed, or filled or unfilled polygon. An open polygon has a
space between its first and last ducks; a closed polygon is a continuous line. A filled polygon uses the 
full area of its geometry. An unfilled polygon uses the perimeter line of the geometry.

If you choose Open, you can turn Taper on or off. When Taper is active, you can alter the width, 
opacity, and color of the line, from one end to the other, by using the Start Conditions and End 
Conditions settings, described below. If you choose Closed, you can turn Fill on or off, but you cannot 
use Taper. Conversely, if you choose Open, you cannot turn on Fill.

Start Conditions/End Conditions: The Start Conditions box lets you specify alternate width, opacity, 
or color settings than those defined on the sliders bar at the bottom of your screen. To render your 
polygon using the current paintbrush settings, click to activate the options below Current Brush. To use
the alternate settings, turn off the associated Current Brush setting.

The End Conditions box is only available when the Open and Taper options are active in the Style box.
The End Conditions specify the width, opacity, and color of the end of a tapered polygon. When a 
tapered polygon is rendered, the values specified in the Start Conditions box are used for the start of 
the polygon, and the values specified in the End Conditions box are used for the end of the polygon. 
The three values are smoothly tweened, or interpolated, from start to end, over the length of the 
polygon. 

The Copy button copies the settings from the Start Conditions box into the End Conditions box. The 
Swap button switches the settings between the two boxes.



View Options

Lets you set options that affect certain items in the View menu. A dialog box appears listing the options.

To adjust an option, do this:

1. Select the option you want to set from the View Option list at left. The available fields at right 
change, depending on the option you select.

2. Enter your changes in the fields to the right of the View Option list.
3. Click on OK to accept the changes, or Cancel to cancel the changes.

The Default Value button resets the selected option to the values preset by Altamira Composer.

The View Options dialog box contains the following options:

Monitor Gamma: Lets you adjust your monitor gamma setting. This setting affects the luminance of the 
midranges on your monitor display. Since each monitor has slightly different gamma output, you'll need to 
set this to match your own personal preferences. This setting does not affect the color values of your 
image pixels. Each graphics software application reacts differently to your monitor's gamma. Thus, the 
same image may appear darker when displayed in one software program, and lighter in another. Also, 
since all monitors vary, the same image displayed by the same software may appear lighter on one 
monitor and darker on another. The default setting for this option is 180, which is 100 times a 1.8 gamma 
setting.

Pixel Spacing Ratio: Sets the width-to-height ratio of your pixel display. Microsoft Windows displays use 
the default setting of 1.0, which is square pixel spacing. However, various broadcasting video displays 
and framebuffers use different pixel spacing ratios. If your display uses non-square pixel spacing, the 
following commands will not function properly, regardless of the Pixel-Spacing-Ratio setting: Transpose 
Right, Transpose Left, Rotate Right 90, and Rotate Left 90. (See their descriptions, beginning on page 4-
60). If you have an incorrect Pixel-Spacing-Ratio setting, many of the Transform commands, and 
particularly the Rotate command, will not function properly. In addition, circles will become ellipses, and 
squares will become rectangles.

Composition Guide Color: Lets you specify the color of the composition guide. This defaults to a 
medium gray (136,136,136) but can be any RGB color. This color is also used to replace the alpha 
channel when you import or export an image that does not have alpha. For example, if you export an 
image with the Image File Write Alpha option in the File Options dialog box set to No, the clear pixels 
contain this color.    See also New Composition.



Show Tool Bars

Displays a dialog box with which you can turn on or off the display of one or both tool bars.

    Select Both Tool Bars to display both bars, select One Tool Bar to display only the second bar, or �
select No Tool Bars to remove both tool bars from the screen display.



Smart Cursor

Turns the smart cursor on or off. When the smart cursor is on, the mouse cursor displays text describing 
the tool-bar icon that it's over. When smart cursor is off, no text is displayed. A check mark preceeds this 
item when it's on.



The Help Menu

Lets you access on-line reference help for Altamira Composer, or view the current version and registered 
owner. You can also access help by pressing F1. In addition, Help buttons are available in most dialog 
boxes. Click on the Help button to display a description of how to use the dialog box.

These are the items in the Help menu:

Contents
Search for Help on
About Altamira Composer



Contents

Displays the contents page of the on-line help documentation.

    Click on any underlined words to see information on that topic. Double-click the Control-menu �
box in the upper-left corner of the window to exit help.



Search for Help on

Displays the Search dialog box for the on-line help.

1. Select a word from the scrolling list, or type one into the text field.
2. Click on Show Topics to see topics related to the selected word.
3. Click on Go To to display information about the selected topic.

Note: You can also display the Search dialog box by clicking on the Search button from any help page.



About Altamira Composer

Displays a message box containing information about Altamira Composer, including the current version 
number, the name of the registered owner, a copyright notice, and program credits. Click on OK to exit the
message box.



[BASIC CONCEPTS



What is Altamira Composer?
Altamira Composer is an image composition application. It provides filters, transformations, image 
processing, paint tools, splines, and much more. But its unique characteristic is its ability to create a 
picture that is actually a collage of images. It provides tools to cut out irregularly shaped images from 
standard, rectangular pictures, and then combine the new images, as raster objects.

Instead of painting on a single, fixed image, you work with many images that you move, group, process, 
and manipulate using the functions in Altamira Composer. It is this combination of images that becomes 
your composition.

Another distinguishing feature of Altamira Composer is its use of the alpha channel. The alpha channel 
provides varying levels of transparency to each of the pixels (picture elements) in your images. Altamira 
Composer uses the alpha channel to maintain smooth, antialiased edges around the borders of all of your
images, no matter where you move them within the composition. 

Since your raster images can now have perfectly clear areas, they are not limited to rectangular shapes, 
but can be any profile with any number of cutout "holes." In fact, because the alpha channel provides 
multiple levels of transparency, you can have translucent images. For example, you might have a blue 
wine glass containing red wine. You can move it anywhere in your composition and the images beneath 
the glass are tinted blue while the images beneath the wine are tinted red. Wherever you place it, the 
edges of the wineglass are perfectly smooth with absolutely no "jaggies."



Elements of a Composition

When you begin a project in Altamira Composer, you are presented with a window that looks out on a 
void. The void is simply a blank area over which you layer the images of your composition. Over the void, 
you create a composition. A composition is the visual project you are working on.

Note: A part of the void is a colored rectangle called the composition guide. It can be any color that you 
specify but, as its name suggests, it is only a guide to be used as a reference while you create your 
composition. Like the void, the composition guide cannot be painted on-although you can resize it and 
change its color. See also New Composition.

The composition is made up of one or more images. An image is a 32-bit color raster picture of any size. 
You can have as many images as you like in your composition, but only one image is activeor current at a
time. All of the functions in Altamira Composer are applied to the current image. To make an image 
current, you simply click on it.

Each image is confined to a rectangular area called the bounding box. But because of the alpha channel, 
parts of the rectangular area can be transparent, or clear. For example, your image might be a donut. The
donut "hole" and the area outside the curvature of the donut are clear, but are still part of the image and 
are contained in its bounding box.

The donut itself is made up of nonclear pixels. (A pixel is a picture element, which is the smallest, 
changeable unit in your image.) The nonclear pixels in an image are called the shape. The shape of an 
image can be any transparency level except clear.

The bounding box is usually invisible, but it appears when you apply certain functions to the image. For 
example, while you drag or rotate an image, its bounding box appears. You can temporarily display the 
bounding box at any time by pressing the Shift key.

Each image in your composition is loaded from disk as a file and arranged in layers on a stack. The stack 
maintains the order of the images, from front to back, as they are seen from your display screen. The first 
image you load is placed at the back of the stack, the next image is placed in front of it, and so on. When 
you move the images around on the screen, their order on the stack is maintained. Of course, Altamira 
Composer includes commands that let you change the order of the images on the stack.

To select an image as the current image, you click on its shape. (Remember, the image shape is the non-
clear pixels in the image.) If the image is over the void, however, you can select it by clicking anywhere 
within its bounding box.



Channels

Each pixel in an image is described by four channels of data that define the mixture of red, green, and 
blue colors, plus the alpha transparency. These channels are referred to as RGBA (Red, Green, Blue, and
Alpha). Using various functions in Altamira Composer, you can increase or decrease the intensity of each 
of these channels for every pixel in an image. Altering the intensity of the RGB channels produces 
combinations that alter the hue of a pixel. Altering the intensity of the alpha channel changes the 
transparency of a pixel.



The Altamira Composer Screen

When you first run Altamira Composer, your screen displays a window which includes the following 
elements:

The Title Bar
The Menu Bar
The Tool Bars
The Swap Buttons
The Workspace
The Sliders Bar
The Current Color Swatch
The Status Bar



The Title Bar

When the current view is maximized, the name of the current composition plus the name and size of the 
current view window appear in the Altamira Composer title bar. If the current view is not maximized, or 
you have two or more views in the workspace, then the title bar of each view window displays its name 
and size, and the main title bar displays the name of the current composition. 

As with most Windows applications, any window that is not maximized can be repositioned by dragging its
title bar. Click on the minimize and maximize buttons in the upper-right corner, or drag the borders of a 
window to resize it. You can exit Altamira Composer by double-clicking on the control menu box in the 
upper-left corner. See appendix A, "Using Windows" for more about the Windows controls.



The Menu Bar

The menu bar is directly beneath the title bar and contains most of the commands and functions that are 
available in Altamira Composer. See Menu Bar Contents for a complete listing of all menu bar items.



The Tool Bars

There are two tool bars beneath the menu bar. Each contains buttons that duplicate most of the functions 
in the menu bar. Thus, you can select many of the functions in Altamira Composer by simply clicking on a 
button in a tool bar rather than entering a pull-down menu.

As you move your mouse cursor over each button, the cursor changes to display the title of the button. In 
addition, the status bar at the bottom of the screen displays a more complete message. For example, 
when the cursor is over the Crop button, the cursor displays "Crop," and the status bar displays: "Crop 
image to smaller size."

Note: You can turn off the text display of the cursor with the Smart Cursor item in the Options menu.



The Swap Buttons

Since there are many more functions in Altamira Composer than can fit in two rows of buttons, the 13 
buttons in the left half of the lower tool bar can be swapped with other sets of buttons by performing these
steps:

1. Right-click anywhere in the tool bar area.
Result: A menu appears listing sets of buttons by function category.

2. Click to select one of the sets on the list.
Result: The 13 buttons in the left half of the lower tool bar are replaced by a new set of buttons.

You can customize the tool bar by designing your own set of swap buttons. This procedure is described in
appendix B of your Reference Manual, "Customizing the Tool Bars." Each set that you create appears at 
the top of the swap list.



Using Tools

Each of the tools or commands in Altamira Composer is activated either by selecting the command from 
the pull-down menus, or by clicking on its associated tool bar icon. Some commands take place 
immediately, while others place you in a mode in which you continue to use the command until you 
choose to exit. The specific operation of each of the commands is described in chapter 4 of your Owner's 
Manual. However, there is a common method for exiting the commands.

When you are finished with a command, you can exit as follows:

1. Right-click to display a menu at the mouse cursor.
Result: The menu offers two choices: Continue or Done.

2. Select Done to complete the actions of the command and exit. Select Continue if you change your 
mind and want to continue using the tool without exiting.

The following keyboard alternatives are also available:

    After selecting a command, you can press Esc to exit the command without using it.�

    While in a command, pressing Enter is the same as right-clicking and selecting Done.�

    Pressing the Spacebar is the same as right-clicking and displays the Continue/Done menu. This �
is useful for some graphic tablets where right-clicks might be awkward.



The Workspace

The workspace is the large area beneath the tool bars in which you place your composition and edit your 
images. The composition itself appears in one or more windows within the work area. You can work on no
more than one composition at a time in Altamira Composer, but you can open several windows to view 
different areas of the same composition, or different zoom levels. See New Composition, and New 
Window.



The Sliders Bar

The sliders bar contains sliders and buttons that let you adjust the current opacity, the size of your 
touchup paintbrush, the edge of the paintbrush, and the current color. You can also choose the method of 
application for Touchup and Warp functions. From here, you can also pan or center the view window. At 
times, additional controls appear here when you have selected specific functions, such as Dodge-Burn in 
the Touchup menu.

From left to right, the following controls are available:

The Opacity Slider
The Paintbrush Size Slider
The Paintbrush Edge Button
The Center-on-Point Button
The Pan Button
The Center-on-Image button
The Current Color Swatch
The Pick Color Button
The Applicator Buttons
Additional Controls



The Opacity Slider

The opacity slider affects the opacity or transparency of many of the functions in Altamira Composer. For 
example, if you paint across an image using Color Atop , the opacity slider affects the transparency of the 
current color. Set at 50, only 50 percent of the color is applied.

Some functions use the opacity setting to affect the subtlety of the operation rather than the opacity. For 
example, the opacity slider affects the strength of the Smear Atop and Smear Over tools .



The Paintbrush Size Slider

Specifies the diameter of the paintbrush, which can range from 1 to 24 pixels. The paintbrush is used by 
the commands in the Touchup menu. and some of the Warps.

The paintbrush cursor appears as a circular outline. The size of the circle changes to reflect the size of 
the paintbrush. However, if the paintbrush size is too small to be seen in the current view window, it 
appears as a small cross.



The Paintbrush Edge Button

The button to the right of the paintbrush size slider lets you set the edge of the paintbrush. Each time you 
click on this button, it changes to one of three possible paintbrush edgessoft, medium, or hard. The hard-
edge setting is signified by a large black dot within the button, the soft-edge by a small black dot, and the 
medium edge by an intermediate-sized dot.

The paintbrush is always a disk shape. This button sets the falloff at the edge of the paintbrush. A hard 
paintbrush is dense throughout, with the exception of a single-pixel border of partially transparent pixels 
that create a smooth, anti-aliased edge; a soft paintbrush tapers from a dense center to a transparent 
edge; and a medium paintbrush is midway between these two extremes.



The Center-on-Point Button

Centers the view of the current window to a spot you click on with the mouse.

    Click in any composition view window-whether active or inactive.�

Result: The area of the composition that you clicked on is centered in the current view window.

See also The Center-on-Image Button.



The Pan Button

Lets you pan the current view window once. This is different than the Pan command in the View menu, 
which lets you repeatedly pan any view window. Here, the pan button lets you pan the current view 
window only once.

This is how to use the pan button:

1.    At any time, click on the pan button.
Result: The cursor changes to the pan cursor.

2. Click and drag the mouse in the active view window to display a line. When you release the mouse, 
the window view is panned.

3.    Continue with what you were doing. If you want to repeat the pan, click on the pan button again, 
and repeat step 2.

The keyboard alternative for this button is F4.



Center-on-Image Button

Changes the view in the current window so that the current image is in the center of the view.

1.    Activate an image that you want in the center of the view.
2. Click on the center-on-image button.

Result: The view is panned to center on the active image.

See also The Center-on-Point Button.



The Current Color Swatch

The Color Selection dialog box appears when you click on the current color swatch in the sliders bar. 
From the Color Selection dialog box, you can select the current color from among over 16.7 million 
available colors (depending on the capabilities of your graphic display card).

You create a new color by either dragging the controls in the upper area of the dialog box, or entering new
values in the fields in the lower area. The new color is displayed in the swatch labeled New. When you 
click on OK, you exit the dialog box and the new color becomes the current color.

Hue/Blackness box: This box displays a spectrum of colors ranging in hue horizontally, and 
increasing in blackness vertically. The top row of colors is pure, while the blackness of the colors 
increases toward the bottom of the box. The Hue/Blackness box has three controls: 

    Drag the arrow at the top of the box left or right to change the hue.�

    Drag the arrow at the left side of the box up or down to change the amount of blackness in the �
color.
    A small cursor within the Hue/Blackness box indicates the new color. You can drag this cursor �
anywhere within the box to select a color.

Whiteness box: The Whiteness box lets you add whiteness to the color. The color at the top of the 
box is the same as that under the cursor in the Hue/Blackness box. Drag its arrow downward to 
increase the amount of whiteness in the color.

Note: The Blackness and Whiteness controls are not interrelated. Decreasing the whiteness in a color,
for example, is not the same as increasing its blackness. If you want a pure color with no blackness or 
whiteness, drag both the Blackness and Whiteness arrows to the top of their boxes.

Current/New: The Current color swatch displays the current color and does not change until you've 
clicked on OK to exit the Color Selection dialog box. The New color swatch displays the color you are 
choosing.

Copy: Click on the Copy button to copy the current color to the New color swatch. In essence, this 
cancels any changes you've made since you entered the dialog box.

Red/Green/Blue: Use these number boxes to directly enter the RGB values of the color you want. 
Each represents the intensity level (0-255) of the red, green, or blue component of the color. Pure 
primary colors are achieved by setting one of these boxes to 255 and the other two to 0. Pure 
secondary colors (yellow, magenta, and cyan) are achieved by setting two of the boxes to 255 and the 
third to 0. When all three boxes contain the same value, the result is gray.

Hue/Saturation/Value: Use these boxes to enter the HSV value of the color. Hue is the color, 
saturation is the purity of the color, and value is the intensity of the color. As you change the Hue 
setting, the color changes. Increasing the Saturation setting decreases the amount of gray in the color. 
Increasing the Value setting increases the red, green, and blue components of the color equally.



The Pick Color Button

The pick color button is the small, colored button to the right of the current color swatch. It lets you set the
current color and, optionally, the current opacity from any pixel on the display screen. You can perform 
this at any time-before a function, in the middle of a function, or after a function.

To pick the current color, do this:

1.    Click on the pick color button.
Result: The cursor changes to a pick color cursor.

2.    Click on a pixel in any view window.
Result: The current color changes to the color of the pixel you've selected.

By setting the Pick Color Picks Opacity option in the Edit Options dialog box, this button will also change 
the current opacity setting based on the opacity of the selected pixel.

The result of the pick color operation varies depending on the opacity of the selected pixel, and the 
grouping of the image containing the pixel:

    If you pick an opaque pixel in a single image, or an image that is part of a selection set, the �
current color becomes the same as the pixel you select. (If the Opacity option is turned on, the 
opacity slider is set to 100.)
    If you pick a semi-opaque pixel in a single image, or an image that is part of a selection set, the �
current color becomes the same as the pixel. (If the Opacity option is turned on, the opacity slider 
changes to reflect the opacity of the pixel.)
Note: The resulting color might not appear the same as that on the screen because colors behind 
the semi-opaque pixel will alter its apparent hue.
    If you pick a semi-opaque pixel in an image that is part of a � group, the current color becomes a 
combination of the color of the selected pixel, plus any pixels behind it that can be seen.
In most cases, this means that the current color becomes the same as the apparent color of the 
pixel you've selected. However, if all of the layered, grouped images are semi-opaque, a 
percentage of the void is added to the color calculation. Although the void is gray, and its 
composition guide can be any color, the true color value of the void is zeroor black. Thus, the 
resulting color will look darker than the apparent color you pick. On the other hand, the 
transparency value of the void is zero, so it will not affect the resulting transparency in the 
operation-which will be a combination of the transparency value of the grouped pixels. (If the 
Opacity option is turned on.)
If you click over the void, the current color becomes black. (If the Opacity option is turned on, the 
current opacity becomes 0).



The Applicator Buttons

The three applicator buttons in the sliders bar are the equivalent of the Use Paintbrush, Use Template, 
and Use Full Image items in the Touchup menu. They let you choose one of three methods of applying 
Touchup functions, plus some of the Warps. From left to right, the buttons select:

    Paintbrush�

    Brush Template�

    Full Image�

When paintbrush is active, you can apply a Touchup or Warp function by dragging a circular brush. The 
size of the brush is set with the paintbrush size slider, and the edge of the brush is set with the paintbrush
edge button.

When brush template is active, you can apply a Touchup or Warp function using a brush template. A 
brush template is a shape derived from another image in the composition. When you apply a function 
using a brush template, the effect of the function is confined to the shape of the template. For example, if 
the brush template image is diamond-shaped, you can erase diamond-shaped areas of your image. 

When full image is active, the chosen function is applied to the full image.

See Select Template Image and The Touchup Menu for more about brush templates and the various 
applicators.



Additional Controls

Certain functions in Altamira Composer require additional, interactive controls. When you select these 
functions, their controls appear in the sliders bar. For example, when you select Step Contrast from the 
Touchup menu, a slider appears to the right of the sliders bar. The Step Contrast slider runs from -50 to 
50 with 0 in the middle. Negative values decrease the contrast in the image, while positive values 
increase the contrast.



The Status Bar

The status bar displays text prompts while you use the program, and information about the current image.
For example, while using the Transforms, rotation angles, scaling percentages, and offsets are shown. 
The status bar also displays an extended description of each tool-bar button while the cursor is over the 
button.

The box at the far right of the status bar displays the current mouse x/y coordinates, based on the 
composition guide. The upper-left corner of the composition guide is 0,0. The x dimension increases as 
you move right, and the y dimension increases as you move down. See New Composition for information 
about the composition guide.




